# Table of Contents

## Getting Started

- About This Manual ............................................... 1-1
- Welcome .......................................................... 1-2
- Installing CMS for Windows ........................................ 1-4
  - System Requirements ........................................... 1-4
  - PC Installation ................................................ 1-5
  - CMS Installation ............................................... 1-10
  - Multi-user Setup ................................................ 1-11
  - Starting CMS for the First Time ............................... 1-11
- Basic Concepts ..................................................... 1-14
  - About Windows .................................................. 1-14
  - Navigating the Menu ............................................ 1-15
  - About Environment .............................................. 1-17
- Technical Support .................................................. 1-17
  - About CMS ....................................................... 1-18
- Login/Logout/Exit .................................................. 1-19
  - Login ............................................................ 1-19
  - Logout .......................................................... 1-19
  - Exit .............................................................. 1-19
- Preferences ......................................................... 1-20
  - Show/Hide Date and Time ...................................... 1-20
  - Report Preferences ............................................. 1-21
- Setup ............................................................... 1-22
  - Auto-Update Setup .............................................. 1-22
  - Emergency Report Setup ....................................... 1-24
  - COM Port Setup ................................................ 1-27
- Pager Setup ........................................................ 1-29
  - Add Pager ........................................................ 1-31
  - Pager Jobs ....................................................... 1-33
  - Pager Schedule .................................................. 1-34
  - Add a Pager Schedule ......................................... 1-35
Setting Up a Job

Setting Up a Job

Add System ........................................ 2-1
Modem Connection .................................. 2-2
Ethernet Connection .............................. 2-2
Address ........................................... 2-3
Contact .......................................... 2-3
Mechanic ......................................... 2-4
Elevator Company .................................. 2-5
Listing ............................................. 2-7
Open System ...................................... 2-7
Modify System ..................................... 2-9
Edit ............................................... 2-9
Add ............................................... 2-10
Delete ............................................ 2-10
View .............................................. 2-11
Close System ..................................... 2-11

Monitoring a Job

Monitoring a Job

Connecting to a Job .................................. 3-1
Disconnecting from a Job ........................... 3-3
Real Time Clock .................................... 3-4
Controller CMS Parameters ........................ 3-6
Without CGP Processor ............................ 3-8
Modem Parameters .......................................................... 3-9
Controller Configuration .................................................... 3-10
  Labels ........................................................................... 3-11
  Stops/Openings .............................................................. 3-12
  Options .......................................................................... 3-13
  COM Ports ....................................................................... 3-14
Dispatcher .............................................................................. 3-15
  System Parameters ........................................................... 3-16
  Dispatching Configuration ............................................... 3-18
  Timer Table ................................................................... 3-20
  Lobby Up Peak ................................................................ 3-22
  Variables for Lobby Up Peak ............................................ 3-24
  Car Operating Parameters ............................................... 3-25
Keyboard Control for Elevators .............................................. 3-27
  Independent Service ........................................................ 3-30
  Car to Lobby .................................................................. 3-33
  Out of Service ................................................................ 3-36
  Swing Operation ............................................................. 3-39
Programmable Events .......................................................... 3-41
Hoistway Display ................................................................. 3-43
Car Flags ........................................................................... 3-46
Car Status ........................................................................... 3-47
Group Status ......................................................................... 3-49
Options ............................................................................... 3-50
  Update Reports ............................................................... 3-50
  Auto-Update .................................................................. 3-50
  Create Maintenance Log ................................................. 3-51
  Security Interface Software ............................................ 3-52
Reports

  Common Report Windows .................................................. 4-2
    Cars In Service ............................................................ 4-2
    Graph Type ................................................................... 4-3
    Search ......................................................................... 4-3
    Sort ............................................................................. 4-4
Part # 42-02-S021
<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency Report</td>
<td>4-5</td>
</tr>
<tr>
<td>Date and Time</td>
<td>4-6</td>
</tr>
<tr>
<td>Select</td>
<td>4-7</td>
</tr>
<tr>
<td>Preferences</td>
<td>4-8</td>
</tr>
<tr>
<td>Summary</td>
<td>4-9</td>
</tr>
<tr>
<td>Cars In Service</td>
<td>4-10</td>
</tr>
<tr>
<td>Sample Analysis</td>
<td>4-10</td>
</tr>
<tr>
<td>Emergency Transmission Errors Report</td>
<td>4-10</td>
</tr>
<tr>
<td>Date and Time</td>
<td>4-12</td>
</tr>
<tr>
<td>Select</td>
<td>4-12</td>
</tr>
<tr>
<td>Preferences</td>
<td>4-13</td>
</tr>
<tr>
<td>Cars In Service</td>
<td>4-14</td>
</tr>
<tr>
<td>Summary</td>
<td>4-14</td>
</tr>
<tr>
<td>Search</td>
<td>4-14</td>
</tr>
<tr>
<td>Sample Analysis</td>
<td>4-14</td>
</tr>
<tr>
<td>Hall Call Analysis</td>
<td>4-15</td>
</tr>
<tr>
<td>Date</td>
<td>4-16</td>
</tr>
<tr>
<td>Preferences</td>
<td>4-17</td>
</tr>
<tr>
<td>Cars In Service</td>
<td>4-17</td>
</tr>
<tr>
<td>Sample Analysis</td>
<td>4-17</td>
</tr>
<tr>
<td>Hall Call Log</td>
<td>4-18</td>
</tr>
<tr>
<td>Date and Time</td>
<td>4-19</td>
</tr>
<tr>
<td>Select</td>
<td>4-20</td>
</tr>
<tr>
<td>Preferences</td>
<td>4-21</td>
</tr>
<tr>
<td>Cars In Service</td>
<td>4-22</td>
</tr>
<tr>
<td>Summary</td>
<td>4-22</td>
</tr>
<tr>
<td>Sample Analysis</td>
<td>4-23</td>
</tr>
<tr>
<td>Traffic Analysis</td>
<td>4-24</td>
</tr>
<tr>
<td>Car Call Log</td>
<td>4-27</td>
</tr>
<tr>
<td>Date and Time</td>
<td>4-28</td>
</tr>
<tr>
<td>Select</td>
<td>4-29</td>
</tr>
<tr>
<td>Preferences</td>
<td>4-30</td>
</tr>
<tr>
<td>Cars In Service</td>
<td>4-31</td>
</tr>
<tr>
<td>Summary</td>
<td>4-31</td>
</tr>
<tr>
<td>Sample Analysis</td>
<td>4-32</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>System Performance</td>
<td>4-33</td>
</tr>
<tr>
<td>Date</td>
<td>4-34</td>
</tr>
<tr>
<td>Preferences</td>
<td>4-35</td>
</tr>
<tr>
<td>Summary</td>
<td>4-36</td>
</tr>
<tr>
<td>Sample Analysis</td>
<td>4-36</td>
</tr>
<tr>
<td>Hall Call Distribution</td>
<td>4-37</td>
</tr>
<tr>
<td>Date and Time</td>
<td>4-38</td>
</tr>
<tr>
<td>Preferences</td>
<td>4-39</td>
</tr>
<tr>
<td>Cars In Service</td>
<td>4-39</td>
</tr>
<tr>
<td>Sample Analysis</td>
<td>4-39</td>
</tr>
<tr>
<td>Event Calendar</td>
<td>4-40</td>
</tr>
<tr>
<td>Date and Time</td>
<td>4-41</td>
</tr>
<tr>
<td>Select</td>
<td>4-42</td>
</tr>
<tr>
<td>Preferences</td>
<td>4-43</td>
</tr>
<tr>
<td>Cars In Service</td>
<td>4-44</td>
</tr>
<tr>
<td>Summary</td>
<td>4-44</td>
</tr>
<tr>
<td>Search</td>
<td>4-44</td>
</tr>
<tr>
<td>Sample Analysis</td>
<td>4-45</td>
</tr>
<tr>
<td>Maintenance Log</td>
<td>4-45</td>
</tr>
</tbody>
</table>

**Appendix**

- Appendix A: Car Status Messages ........................................... 1
- Appendix B: User Tasks (Privileges) .................................... 6
- Appendix C: Pager Events List ............................................. 15
- Appendix D: Running CMS in Windows® XP ................................. 22
This manual describes how to use the Central Monitoring System (CMS) for Windows. It is a comprehensive elevator management tool that can be used to enhance quality and increase productivity. It is a useful tool for institutions, contractors, building managers and owners with many elevators in the same building, or in multiple buildings in the same city, or even in different cities and states.

This manual is divided into the following chapters:

**Chapter I, Getting Started**
This chapter gets you started using CMS for Windows. You will be informed on how to install CMS for Windows, setup user logins and passwords, navigate the menu, and determine Preferences and Setups.

**Chapter II, Setting Up a Job**
This chapter outlines the procedure for adding a job, which includes entering the address, contact, mechanic, and elevator company. This chapter also describes the steps necessary for opening a job, modifying a job, which includes editing, adding, deleting, and viewing, and finally, closing a job.

**Chapter III, Monitoring a Job**
This chapter shows how to connect and disconnect from a job. Once connected to a job, all the available options are explained.

**Chapter IV, Reports**
This chapter describes all the reports and report options available in CMS for Windows.
Welcome

Welcome to CMS for Windows, a simple and easy tool to use! CMS for Windows provides easy-to-use pull-down menus, using the Microsoft Windows operating system.

CMS for Windows monitors elevators attached to a system. When an elevator shutdown occurs, the elevator system shall initiate an emergency call to the elevator command center. CMS for Windows shall receive and process an emergency call by displaying the event on the monitor screen, sending a message to a pager, and printing the event on a designated printer.

While connected to the elevator system, CMS for Windows downloads and collects available data, which is organized in a database. This allows the user to monitor and review the elevator performance database in different formats.

CMS for Windows also provides appropriate menus for monitoring the elevator system, and where applicable, for altering various elevator system parameters. Each individual user’s interaction level with the system shall be defined by the monitoring system manager.
CMS for Windows Configuration

CMS for Windows is typically located at a remote site and is connected to elevator systems by means of modems through telephone lines. CMS for Windows can also connect to elevator systems by means of line drivers, Ethernet and serial cables. However, there are limitations associated with the number of elevator systems which can be attached using these types of connections. CMS can also use your existing Ethernet network to communicate with the elevator systems. Your Ethernet network must support Transmission Control Protocol/Internet Protocol (TCP/IP) communication.

CMS for Windows hardware consists of an IBM compatible computer, printer, and two modems (if applicable). This computer provides the user with an interface to the CMS for Windows system and the elevator controller.

Each elevator system being monitored must have all the hardware and software required to interface with CMS for Windows. MCE controllers require an Elevator Monitoring Interface (EMI). This interface is available on all new MCE controllers, however, it may require minor hardware and/or software changes on existing controllers.
Installing CMS for Windows

System Requirements

CMS for Windows is installed at a designated location for central monitoring. CMS for Windows maintains a database as it communicates with and monitors the various attached elevator control systems.

CMS for Windows hardware includes a personal computer (PC), printer, modems and other peripherals to effectively perform the required functions. As a minimum, the hardware includes two modems, one parallel printer, two dedicated analog phone lines and a computer as listed below.

✔ Pentium PC with:
   - 32 MB RAM
   - 1 GB hard disk
   - 2 or more serial ports
   - 1 parallel port
   - 1 CD ROM (3.5" floppy disk drive may substitute)
   - 1 VGA card
   - 1 Windows® 95, 98, NT4, 2000 or XP*

   * See Appendix D, Running CMS in Windows® XP

✔ 1 VGA monitor

✔ 1 Parallel printer with cable, compatible with Microsoft Windows (color optional)

✔ 2 Hayes compatible 14.4K or higher baud modems:
   - 1 for incoming Emergencies
   - 1 for outgoing Inquiries

✔ 1 Ethernet Card compatible with your network (optional).
The following steps describe the hardware installation of the Central Monitoring System’s computer:

1. Remove the PC from its box. Place the PC in a location which will not be disturbed. Plug the 120V power cable into the PC power plug and the other end into a 120V wall outlet.

NOTE: The serial ports (COM1 and COM2) may be used for:
- external modems (see instructions on page 1-8)
- line drivers (see instructions in the Computer Peripherals manual, MCE part # 42-02-CP00)
- terminal servers (see instructions provided with the terminal server).
2 Remove the monitor from its box and set it on top of the PC. Plug the 120V power cable into the VGA monitor and the other end into a 120V wall outlet. Plug the VGA monitor's video cable into the PC's video port located in the rear of the PC.

3 Remove the keyboard from its box and plug the cable into the PC's keyboard port.
4 Remove the mouse from its box and plug the cable into the PC’s mouse port.

5 Remove the printer from its box and set it next to the PC. Plug the 120V power cable into a 120V wall outlet. Use a parallel printer cable (Centronics cable) to connect the PC to the printer. Attach the 25-pin male end of the cable into LPT1 (printer port) of the PC. Attach the other end of the cable into the Centronics connector of the printer.
If external modems are being used, set them next to the PC. Plug the transformer end of the modem power cord into a 120V wall outlet and the other end into the rear of the modem. Use the modem cable to connect the modem to the PC serial port (COM1 or COM2).

**NOTE:**
The PC requires two modem connections, one to COM1 and the other to COM2. The PC requires two dedicated analog phone lines to communicate properly with the elevator systems.

One analog phone line is dedicated to receiving emergencies and the other phone line is used for dialing out and manually connecting to a job site. This ensures that CMS for Windows will promptly receive all emergencies.

This is recommended for job sites with two or more systems attached.
7  Connect the dedicated analog phone lines to the modems using a standard phone cord. Plug the dedicated phone line into the modem's line jack as shown above. If using an internal modem, refer to the following figure.

8  At this point, the PC should be connected properly.
**CMS Installation**

Since the CMS for Windows files are compressed, you must use the CMS for Windows installation program to copy the files onto your hard disk. CMS for Windows comes on CD. If you do not have a CD drive, contact Motion Control Engineering, Inc. Technical Support at (916) 463-9200 #6 to obtain 3.5" installation disks.

To install CMS for Windows on your hard disk:

1. Start Windows if you have not already done so.
2. Insert CD into CD ROM drive.
3. Choose **Run** from the **Start** menu in the Windows Program.
4. Select browse and CD ROM drive. Select setup and **OK**.
5. The first screen prompts you for the drive and directory where CMS for Windows is to be installed. The default is **c:cmswin**. To use this standard directory, select **OK** to continue. If you prefer, you may change this to another drive letter or an alternate directory name. Select **OK** when the correct drive and directory name are specified.
6. The installation program will then copy the program files from the installation CD into the specified directory. As it copies files, the progress bar will show the percentage of files that have been copied. During installation, a window will be displayed containing additional information about CMS for Windows. Take this time to get more acquainted with the tools provided.
7. You will be prompted, if you wish, to create a program group. Select OK to go ahead and create a program group.

When you've finished installing, put the original software and license certificate in a safe place.

**You can now start CMS for Windows by double clicking on the CMS for Windows icon.**

**Multi-user Setup**

Here is what needs to be done to get multi-user setup for CMS functional.

A single-user setup needs to be done on the machine that will act as CMS database server. Please accept all default settings during the
install. Once this is done, create a shortcut on the desktop that points to C:\CMSWIN\RTDSK50W.EXE file. After the shortcut has been created, right-click on it and choose Properties... In the Target edit box, add -nCMSDatabase after the file path, so everything looks like: C:\CMSWIN\RTDSK50W.EXE -nCMSDatabase Double click on the shortcut, and that should start the database server. Leave it running.

Do a multiuser install on every workstation that will be running CMS. All settings should be the same for each workstation. When multi-user setup prompts you for a database name, please enter CMSDatabase. Repeat the process on each and every CMS workstation.

Starting CMS for the First Time

After you have completed the multi-user setup on your workstation, go to ODBC.INI file which is located in C:\WINDOWS directory of your workstation (client). Then, open it, and find the section that looks like the following:

[CMS020]
DATABASE=c:\cmsgw\CMS020.DA
Driver=C:\CMSWIN\WOD50W.DLL
UID=DBA
PWD=SQL
AutoStop=Yes
Description=CMS for Windows Database
Start=C:\CMSWIN\RTDSK50W.EXE
Start=C:\CMSWIN\RTDSK50W.DLL
Databasefile=C:\CMSWIN\CMS020.DA
EngineName=EngineName=CMSDatabase

Please make sure EngineName=CMSDatabase parameter is there. Also, make sure DATABASE= and Databasefile= parameters point to your database on the network and not the one in C:\CMSWIN folder. If these two parameters do not point to the database path on the network, you will have to manually modify them so they do.

When starting CMS for the first time, you will be prompted to enter your registration information.
The registration information registers this copy of CMS to the user and the organization entered (A and B). To save the registration information click on the OK button (C). To cancel the changes made in this window and exit CMS, click on the Cancel button (D).

Once you enter the registration information, CMS will prompt you to enter the product's serial number.
A serial number is provided with the license agreement. You must have a serial number to use CMS. If you do not have a serial number, please contact MCE's Technical Support Department at (916) 638-4011.

Enter the serial number in the designated field (A). Click on the Update button to save the serial number and start CMS (B). To cancel the changes made, and exit CMS, click on the Cancel button (C).

The serial number entered in this window specifies the number of jobs that can be monitored by CMS at one time. To display the number of jobs you are currently licensed to monitor, please refer to the About CMS section later in this chapter.
Basic Concepts

About Windows

Displayed vertically and/or horizontally on a control. Clicking on the ScrollBar, clicking on the up/down or right/left arrows or dragging the scroll button allows you to view options that are currently not visible.

Smaller square CheckBoxes are used to set independent options.

A GroupBox is used to group related controls, such as RadioButton (ie: "Door" is the name of this GroupBox).

SingleLineEdits are used to enter a single line of text. This line may scroll vertically to allow for more text to be entered than what is displayed.

Click the down arrow at the end of the DropDownListBox to display the options available. Click on an option to select it.

Displays available options or values. If the text in the ListBox exceeds the height and/or width of the ListBox, a vertical and/or horizontal scroll bar will be displayed, respectively. Click on an option to select it. Sometimes more than one option can be selected at a time.

Pressing the 'Alt' key along with the underlined letter provides a shortcut to accessing the control. These are referred to as Hot Keys.

A Command Button performs a specific task when clicked.

A RadioButton is a small round button that is used to turn an option on or off. When the option is on, the button has a dark circle. When the option is off, the center is blank.

A SpinControl allows you to click on the up and down arrow to increase and decrease the value, respectively.
Navigating the Menu

The main screen of CMS for Windows has the following components:

The Icon bar provides a quick method of accessing certain functions.

Equivalent commands are available on the pull-down menus. The Icon bar can be customized to display or not to display text and can be moved to different locations within the Central Monitoring System window. To customize the Icon bar, select **Window** from the pull-down menu and then select **Customize Icon Bar**.
Customize Iconbar

Move
- Left
- Right
- Top
- Bottom
- Floating

Show Text
Hide
Done

Add a new job (system) to the database
Close an opened job
Disconnect an opened job
View the System Performance Report
View the Event Calendar Report
Exit CMS for Windows

Open an existing job
Connect to a job. The user will select the job to connect to.
View the Emergency Report
View the Hall Call Distribution Report
On-line Help
About Environment

Select **About Environment** from the Help menu to see the system information on-line. This information is display only.

---

Technical Support

If you experience problems or have any questions or comments when using CMS for Windows, you can contact Motion Control Engineering, Inc. (MCE) Technical Support at

916-463-9200 (Voice) follow the prompts
916-638-1418 (FAX)
1-800-444-7442 (toll free)
Select **About CMS** from the **Help** menu to see this information on-line.

In addition to MCE contact information, this window displays the registration information and the number of jobs licensed for monitoring by CMS. To increase the number of jobs licensed for monitoring, contact Motion Control Engineering, Inc. and obtain a new serial number.

To change or view the serial number, click on the **Serial Number** button (**A**). This will display the Serial Number window as described in the **Starting CMS for the First Time** section of this chapter.

To close this window, click on the **Ok** button (**B**).
Login/Logout/Exit

Login

CMS for Windows provides user security to limit unauthorized access into CMS for Windows. In most cases, you will need to login to CMS for Windows to fully access the CMS for Windows menus. You must first be setup with a login and password. Contact the monitoring system manager (supervisor) at your site to set this up for you. The Supervisor's User Login is “SUPERVISOR” (case insensitive) and initially has a password of “MANAGER.” The first thing the Supervisor should do is change this password. Refer to the Account Settings section for further details. To login to CMS for Windows, select Login on the menu bar or press ALT-L.

Type your user login and select OK.

Type your password and select OK.

Now you are ready to access the features of CMS for Windows.

Logout

To logout of CMS for Windows, select Logout on the menu bar or press ALT-L.

Exit

To exit CMS for Windows and return to Windows, select Exit from the File menu, press ALT-X, or click on the Exit icon on the Iconbar. You will be prompted every time before exiting. If you are logged in, a different message will be displayed.
Preferences

Show/Hide Date and Time

Show/Hide the display of the PC's current date and time on the Menu bar.

*If this option is selected, the date and time will disappear from the display.*
The Report Preferences window provides preferences with regards to if and what appears on a header page for reports and the amount of data stored in the database.

The data collected by Auto-Update or Update Reports is used to generate various reports concerning the elevator status (events) and traffic analysis of each elevator system. The amount of data stored in the database is user-defined and can be specified in the Report Preferences window.
Auto-Update Setup

There are two different ways to update the reports, manually (refer to the Monitoring a Job chapter) and automatically. Both can be run real-time, but only automatically can be set to run at a specified time. Other features of CMS for Windows can be accessed while either method of updating is used.
1. Highlight the jobs to be updated in the **Jobs** ListBox by clicking on the desired jobs.

2. Click the **Add>>** button or press **ALT-A** to move these jobs to the **Inquire To** ListBox. To remove jobs from the **Inquire To** ListBox, highlight the jobs and click **<<Remove** or press **ALT-R**.

3. To select the reports to be updated, highlight the job(s) in the **Inquire To** ListBox and click the **Select Files** button or press **ALT-F**.

After you click the **Select Files** button (**ALT-F**), another window will be displayed listing the files available to be updated. Depending on the job(s) selected, the files available to update may vary. When selecting jobs that have different files available to update, only the files common between the jobs will be displayed. To see what files each job has available to update, look at each individual job. Use the shortcut of selecting more than one job at a time, if it is known that all the jobs have the same files to update.

4. Select the **Status**. Setting this parameter to **On** activates Auto-Update. To deactivate Auto-Update, set this parameter to **Off**.

5. Select the **Number of Attempts**. This is the number of times CMS for Windows tries to connect and download the data from the elevator system to the CMS for Windows database. You can have a minimum of 1 try and a maximum of 20 tries.
If Auto-Update is activated, CMS for Windows performs the Auto-Update once per day. Currently, **Daily** is the only **Frequency** option available.

Select the **Start Time**. If Auto-Update is activated, CMS for Windows performs the Auto-Update according to the Frequency, at the hour specified by this parameter. You can set the time to any hour of the day.

To save the settings for the Auto-Update, click on the **Save** button or press **ALT-S**. The update will not begin at this time. The update will begin at the Start Time value specified. To begin the update immediately, select **Auto-Update** from the **Options** Menu. Press the **Cancel** button to discard these changes.

---

**Emergency Report Setup**

The Emergency Report Setup window provides a programmable capability for receiving, displaying, and printing the elevator emergencies. To adjust the Emergency Report Setup, select **Setup - Emergency Report Setup** in the **File** menu.

---

![Emergency Report Setup Window](image)

(A) Monitor Emergencies\(\quad\) \(\text{(B)}\)\(\text{(L)}\)

(C) Print Emergencies\(\quad\) \(\text{(J)}\)

(D) Display Emergencies\(\quad\) \(\text{(K)}\)

(E) Display Option\(\quad\) \(\text{(F)}\)

(G) Attention Sound\(\quad\) \(\text{(H)}\)

(I) Display Format\(\quad\) \(\text{(I)}\)
To allow CMS to receive emergencies, set the **Monitor Emergencies** parameter to ‘Yes’ (**A**), then select the ports that are dedicated for emergency monitoring (**B**). CMS for Windows will open an Emergency Monitoring window, for each selected port, that will monitor the port to determine if a controller has sent an emergency. If you selected serial ports, the COM port must be setup properly for the type of media used to monitor the emergencies. Refer to the **COM Port Setup** section for further details on how to setup a COM port. The selected COM port will be dedicated for receiving emergencies and cannot be used to monitor a job. If you intend to monitor a job using one of the COM ports selected for emergency monitoring, CMS will close the emergency monitoring connection and reactivate it after you disconnect from the job. For the Ethernet port, CMS will open an emergency monitoring window that will continuously connect to all Ethernet jobs and poll them for emergencies. If Ethernet is selected, Polling Time adjusts the default timers for polling emergencies from 1 to 60 minutes. The Connect time is adjustable from 45 to 60 seconds in 5 second intervals. The default setting (Idle time 1 min., Connect time 45sec.) does not display.

If the **Monitor Emergencies** parameter is set to ‘No,’ you will not be able to select or deselect a COM port. This will also disable CMS for Windows from receiving any emergency messages from the controllers.

If you are monitoring a port that is using a modem as its media, this window will monitor the modem status. The current status line will indicate whether or not the modem is currently available. This window needs to remain open while monitoring for emergencies. If you close this window, CMS for Windows will not be able to monitor the COM port dedicated to receiving emergencies.
Every time an emergency is received, the Emergency Event window will be displayed.

The other parameters have no effect on the monitoring of emergencies, but they do affect the way CMS for Windows handles the received emergencies.

Set the **Print Emergencies** parameter to ‘Yes’ to automatically print all emergencies that are received from the elevator system. Select ‘No’ to disable automatic printing of all emergencies. This will not affect the **Display Emergencies** selection (C).

If the **Display Option** parameter is set to Auto Clear, the Emergency Event window will close automatically, staying displayed as long as specified in the **Number of Seconds** parameter. The Emergency Event window can be closed before this time by clicking on the **Close** button.

If the **Display Option** parameter is set to Manual Clear, the emergency window will need to be closed manually by clicking on the **Close** button. In this case, CMS for Windows will continue receiving emergencies but will wait until the displayed emergency is cleared before displaying the rest. (E).

The **Number of Seconds** parameter indicates the number of seconds that the emergency will be displayed. This parameter is ignored if Auto Clear is selected (F).

The **Attention Sound** parameter sounds a beep(s) every time an emergency is received. The beep will only sound if the emergency is
displayed. If the **Display Emergency** selection is set to ‘No,’ no beep will sound (G).

The **Sound Option**: enables the use of a Sound Card and speakers if available on the PC. If not, set the Sound Option to PC Speaker. This option is active if **Monitoring Emergencies** and **Attention Sound** are set to *On*. **Number of Beeps**: sets the length of tone played when the PC Speaker option is selected. Range is from 1 to 10. To use the Sound Card option, set the Windows Default sound for whatever sound file you wish to use for the emergency sound. See the Windows Users manual on how to change the Windows Default sound. (H)

The **Display Format** parameter indicates the date and time format to be used for the displayed and printed emergency. This will dictate the date format on the Emergency Event window (I). A sample of the date and time format is displayed using today’s date and the current time.

Click on the **Close** button to be prompted to save your changes and close this window (J).

Click on the **Cancel** button to close this window (K).

**COM Port Setup**

This window allows you to configure the PC’s COM ports to communicate with the elevator system. At least two COM ports need to be specified, one for emergencies and one for inquiries.
After pressing the **Advanced** button the Custom Modem Setup window is displayed.
CMS is capable of notifying designated pagers when a specific job encounters an emergency event. CMS will send a coded message to the pager, which may be either CMS generated or user-defined. Please refer to the **Add Pager** section for further details about the pager message.

In order for CMS to notify pagers of elevator emergencies, the following information must be setup:

- A COM port must be dedicated for this purpose
- A dedicated modem must be connected to the COM ports
- A telephone line must be connected to the modem

Refer to the **COM Port Setup** section of this chapter for more information on setting up the COM ports.

**NOTE:** You must have **Modify** access to Pager Setup, granted by the Supervisor, in order to setup the pagers.

You do not have to be connected to a controller to use Pager Setup.

The Pager Setup window displays a list of pagers added to the system, their phone numbers, and individual statuses.
Click on the **On** RadioButton in the **Pager Option** GroupBox to turn on the paging capabilities of CMS. Click on the **Off** RadioButton in the **Pager Option** GroupBox to turn off the paging capabilities of CMS (A).

Click on the DropDownListBox in the **Pager COM Port** GroupBox to select the COM port to be used for paging (B).

Select a Pager from the list of pagers (H) and click on the **Edit** button to modify the Pager Setup information (D). The Edit Pager window will be displayed.

Click on the **Add** button to add a new pager to the system (E). The Add Pager window will be displayed.

Select a pager from the list of pagers (D) and click on the **Delete** button to delete all the information related to the pager.

Click on the **Print** button to print a report containing the pager name, pager phone number, and pager status (G).

Click on the **Close** button to close this window (C).
To add a new pager to the system, click on the **Add** button in the Pager Setup window. The Add Pager window will appear.

Enter the name of the pager in the **Pager Name** field (A). This name will be used to refer to the pager in other screens.

Enter the pager telephone number in the **Pager Number** field (B). This is the number that CMS will dial to call the pager.

NOTE: You cannot add a pager without a name.

The **Pager Type** DropDownListBox is set to ** Numeric** and has been disabled. The system can only page numeric pagers at this time.

If you want the pager message to be generated by CMS, click on the **CMS Generated** RadioButton in the **Pager Message** GroupBox (D). If **CMS Generated** is selected, a message up to twelve digits long will be generated by CMS and sent to the pager. The contents of the message depend on the number of emergencies received by CMS for that job, as described in the following examples.
EXAMPLE 1: CMS is receiving only one message from a job:

```
0 7 7 7 0 0 2 5 0 0 1
```

The first digit of a pager message is always a 0 indicating that the message is from a CMS station. This is followed by the four digit job number and a 0 used as a separator. The event ID is a three digit number with leading zeroes, followed by a 0 used as a separator. If CMS receives an unknown event, then 999 is displayed in place of the event ID. Please refer to Appendix C for a complete list of pager events. The car number is a two digit number with leading zeroes. If the event is a Group/System event, then 00 is displayed in place of the car number.

EXAMPLE 2: CMS is receiving multiple emergency messages from the same job:

```
0 7 7 7 0 0 2
```

The first digit of a pager message is always a 0 indicating that the message is from a CMS station. This is followed by the four digit job number and a 0 used as a separator. The number of emergency messages received is a two digit number with leading zeroes.

If you want to have your own custom message sent at the time of paging, click on the Custom RadioButton in the Pager Message GroupBox (E). If you choose Custom, then a SingleLineEdit field will be displayed and you must enter a string of numbers up to twenty-four digits long.

Click on the On RadioButton in the Pager Status GroupBox to turn on this pager. To turn the pager off, click on the Off RadioButton (F).

NOTE: CMS will not try to call a pager that is set to Off.
Click on the **Jobs** button to specify the jobs for which this pager will be paged (**G**). The Pager Jobs window will be displayed.

Click on the **Schedule** button to set the dates and times that the pager is active (**H**). ThePager Schedule window will be displayed.

Click on the **Close** button to save the changes and return to the previous window (**I**).

Click on the **Cancel** button to discard the changes and return to the previous window (**J**).

**Pager Jobs**

The Pager Jobs window allows you to specify job(s) for which this pager will be notified.

The pager name is displayed at the top left corner of the window (**A**).

To add a job in the **Pager WILL NOT Respond to** box (**B**) to the **Pager WILL Respond to** box (**I**), select the desired job in the **Pager WILL NOT Respond to** box and click on the **Add** button (**C**).

Click on the **Add All** button (**E**) to add all the jobs in the **Pager WILL NOT Respond to** box to the **Pager WILL Respond to** box.
To move a job from the **Pager WILL Respond to** box to the **Pager WILL NOT Respond to** box, select the job in the **Pager WILL Respond to** box and click on the **Remove** button (D).

Click on the **Remove All** button (F) to remove all the jobs from the **Pager WILL Respond to** box and put them in the **Pager WILL NOT Respond to** box.

Click on the **Close** button to save the changes, close this window, and return to the previous window (G).

Click on the **Cancel** button to discard the changes and return to the previous window (H).

---

**Pager Schedule**

The Pager Schedule window allows you to set the dates and times that the pager is active. CMS will only page a pager at a certain time if the pager is active.

This window displays the pager name (A) and a list of active schedules (B). Each schedule is made up of a date and three time periods. The time period represents the time that the pager is active for the selected date.
To add a new schedule for the selected pager, click on the **Add** button (E). The Add Schedule window will be displayed.

To modify an existing pager schedule, select a pager from the **Pager Schedule** box (B) and click on the **Edit** button (D).

To delete a pager schedule, select a pager from the **Pager Schedule** box and click on the **Delete** button (F).

---

**Add a Pager Schedule**

The Add a Pager Schedule window allows you to add a new schedule.

The pager name is displayed in the **Pager Name** GroupBox at the top left corner of the window (A).

The current date is set by default in the **DropDownList**Box (D). Click on the down arrow next to the date to display the calendar (E). Click on the up/down arrows to the left of the month and year in the calendar to change the month (F). Click on the up/down arrows to the right of the month and year in the calendar to change the year (G). Click on a number in the calendar to select a date.
NOTE: Unused time periods may be left empty. However, incomplete time periods are not allowed. The Start Time of one time period may not overlap with the End Time of the previous time period. Also, the start time of the first time period may not be blank.

For any single day, up to three time periods may be defined during which a pager will be active. Two of the three time periods in the Time Period GroupBox (H) contain default values initially. To change these values, overwrite them with the new values using military time format.

Click on the Close button to save the schedule, close this window, and return to the previous window (B).

Click on the Cancel button to abandon all changes and return to the previous window (C).

Edit Pager

The Edit Pager window allows you to modify the pager setup information. This window is identical to the Add Pager window. Please refer to the Add Pager section of this chapter for more details.
The Maintenance Mechanics setup window allows you to register the mechanics that are permitted to create maintenance logs.

This window displays a list of all the mechanics that have been registered to create maintenance logs. The information includes the mechanic’s identification number (ID), first name, last name, phone number, and the elevator company (A).

To modify the information of a registered mechanic, select the desired mechanic from the list, then click on the Edit button (C). The Edit Maintenance Mechanics’ window will appear. This window will be described later in this section.

To add a new mechanic to the registered mechanics list, click on the Add button (D). The Add Maintenance Mechanic window will appear. This window will be discussed later in this section.

To remove a mechanic from the registered mechanics list, click on the Delete button (E). To print a list of registered mechanics, click on the Print button (F). To close this window, click on the Close button (B).

WARNING: Clicking on the Delete button will remove the selected mechanic’s information, as well as all the maintenance logs created by this mechanic, from the system.
The Add Maintenance Mechanic window allows you to register a new mechanic.

Enter all the mechanic’s relevant information in this window. You must at least enter the Mechanic ID (A) and the mechanic’s first name (B) in this window. The Mechanic ID must be a number between 1 and 9999. The other information, including the mechanic’s last name (C), phone number (D), and company (E) are optional.

To save the new information and close the window, click on the Save button (F). To cancel the changes and close the window, click on the Cancel button (G).
Edit Maintenance Mechanic

The Edit Maintenance Mechanic window allows you to modify the information of an existing maintenance mechanic.

This window is identical to the Add Maintenance Mechanic window described earlier. The only difference is that this window will not allow you to change the Mechanic ID. Please refer to the Add Maintenance Mechanic section for detailed information about the fields in this window.
Auto Hoistway Display Setup

The Auto Hoistway Display is a feature that allows CMS to automatically connect to a job and display its Hoistway screen on start up. The Auto Hoistway display setup window allows you to activate this feature, select the job that CMS will connect to, and select the user that will log in automatically. If you set the Auto Hoistway Display Option ON, then CMS will connect to the specified job and display the Hoistway every time CMS is started. The selected job must have already been added to CMS and its connection information has been entered correctly. The specified user name will identify the user that will be logged in by CMS before it connects to the job. Since CMS will be connecting to the job automatically, it is important that you assign a user that has limited access to the various CMS screens. If you assign a user that has full access to the CMS screens and the system is left unattended, then the CMS system will be unsecured.

To save the changes and close the window, click on the **Save** button. To close the window without saving the changes, click on the **Cancel** button.
CMS for Windows includes an extensive user security feature that allows the system supervisor to control who can access CMS and what they can access.

One person should be designated as the CMS for Windows' Supervisor. This Supervisor has the highest level of access. The Supervisor can add new users, delete users, and grant or revoke users' access to CMS for Windows.

The Supervisor's User Login is “SUPERVISOR” (case insensitive) and initially has a password of “MANAGER.” The first thing the Supervisor should do is change this password.

You must login to CMS for Windows in order to change your password. Once you set a password, any subsequent login to CMS for Windows will require you to enter the password. So, it is important to remember the password you are about to change.
Select **Change User’s Password** or press **ALT-P** to change the password. After entering the current password, you will be prompted to enter the new password. Then you will be prompted to confirm the new password exactly as you had typed it in the previous window. If the two passwords do not match, CMS for Windows will not accept the new password.

The Supervisor can add a new user to CMS by clicking on the **Add User** button or modify a user’s name by clicking on the **Modify User** button. Please refer to **Add User** and **Modify User** later in this section.

The Supervisor can also grant or revoke a user’s access to CMS. There are two types of accesses in CMS for Windows, Jobs and Privileges. Using Jobs access, the Supervisor can specify which jobs the user can connect to.
To give the user full access to connect to all jobs, click on the “user may connect to all jobs” CheckBox (C). If this box is checked, then the user will be able to connect to all jobs.

To allow the user to connect to only certain jobs and not others, deselect the “user may connect to all jobs” CheckBox. Highlight the jobs that the user will have access to in the “User may NOT connect to these jobs” box (A) and then click on the Add >> button. This should move the job to the “User may connect to these jobs” box (B). In this case, the user will only be able to connect to the jobs listed in this box.

To save the changes and close the window, click on the Close button (D). To close the window without saving the changes, click on the Cancel button (E).

Using Privileges access, the Supervisor can specify which CMS for Windows tasks the user can access.
To give the user full access to all CMS for Windows tasks, click on the “user has full privileges” CheckBox. If this box is checked, then the user will be able to use CMS without any restrictions.

To grant the user access to only certain tasks (refer to Appendix B for a list of all User Tasks) and not others, deselect the “user has full privileges” CheckBox. Highlight the tasks that the user will have access to in the “User may NOT do the following” box (A) and then click on the Add >> button. This should move the task to the “User MAY do the following” box (B). In this case, the user will only be able to use the tasks listed in this box.

To save the changes and close the window, click on the Close button (D). To close the window without saving the changes, click on the Cancel button (E).
Select User

Add User

Modify User
Maintenance Timer

This option performs a maintenance clean up and restarts Windows once a day.

NOTE: If you are using Auto Update, set the refresh time to 10 minutes before the Auto Update time.

For Setting the Maintenance Timer:
Select **Setup - Maintenance Timer** from the **File** menu

The default time is 23:59. Set the time using a 24 hour clock time and click on Save. Your computer will restart everyday at the time you set provided the computer is ON and CMS is running. The timer must be enabled to work.
Setting Up a Job

This chapter outlines the procedure for adding a job, which includes entering the address, contact, mechanic, and elevator company. This chapter also describes the steps necessary for opening a job, modifying a job, which includes editing, adding, deleting, and viewing, and finally, closing a job.

Add System

In order to connect to a job, the job must first be added to CMS for Windows. Job Number and Job Name MUST be entered to connect to a job. Select Add System from the File menu to create a new job.

Direct (Serial Cable or Line Driver) Connections
Modem Connection

Required: A descriptive name of the elevator system.

Optional: Represents the building number/name where the elevator is operating.

Type of media that will be used to connect to the controller (B).

The controller type defines the manufacturer and the monitoring interface of the controller (A).

Represents the phone number at the jobs machine room (H).

Represents the PC's COM port that is connected to the job.

 OPTIONAL: Click here to enter the address. (G)

Optional: Click here to enter the contact. (F)

Optional: Click here to enter the mechanic. (E)

Optional: Click here to enter the elevator company. (D)

Click here to see a listing of all jobs. (C)

Ethernet Connection

Required: A four digit number assigned by the user.

Optional: Represents the building number/name where the elevator is operating.

Type of media that will be used to connect to the controller (B).

The controller type defines the manufacturer and the monitoring interface of the controller (A).

Represents the Controller IP address as assigned by your network administrator (H).

Represents the port number of the Ethernet Terminal Server that the controller is attached to.

Click here to save any changes and close this window.

Optional: Click here to enter the address. (G)

Optional: Click here to enter the contact. (F)

Optional: Click here to enter the mechanic. (E)

Optional: Click here to enter the elevator company. (D)

Click here to see a listing of all jobs. (C)

2-2 Setting Up a Job
Address

In order to enter the complete address where the job is located, click on the **Address** button or press **ALT-A**. Enter the pertinent information in the appropriate fields (G).

![Address](image)

Contact

In order to enter the name of the contact person, if any, at the job’s location, click on the **Contact** button or press **ALT-T**. Enter the pertinent information in the appropriate fields (F).

![Contact](image)
Setting Up a Job

Part # 42-02-S021

Mechanic

After clicking the Mechanic button or pressing ALT-M, a display only window will appear (E).

Click the Listing button or press ALT-L to display a window that allows you to modify, add, and delete mechanic information.

Select the mechanics’ information you wish to edit and then click on the Modify, Add or Delete button. Mechanic information can only be deleted if the mechanic has not been assigned to any jobs.
Enter the pertinent information in the appropriate fields.

**WARNING:** If a mechanic’s information is changed, ALL of that mechanic’s jobs will be affected.

---

**Elevator Company**

After clicking the **Elevator Co.** button or pressing **ALT-E**, a display only window will appear (**D**).
Click the **Listing** button or press **ALT-L** to display a window that allows you to modify, add, and delete elevator company information.

Select the elevator company information you wish to edit and then click on the **Modify**, **Add**, or **Delete** button. Elevator company information can only be deleted if no jobs have been assigned to that company.

Enter the pertinent information in the appropriate fields.

**WARNING:** If an elevator company’s information is changed, **ALL** of that elevator company’s jobs will be affected.
After clicking the **Listing** button, a display only window will appear. This window is identical to the Open System window with one exception. This window will not allow you to open a system. See the next page to view this window (C).

To open a system, select **Open System** from the **File** menu.

A System window is opened for each selected job. The job name and number are displayed in the title bar of the window, along with the word 'Connected' or 'Disconnected'. A job is considered connected when the PC has established communication with the elevator controller through a modem, serial cable, or line driver. A job is considered disconnected when this communication becomes severed, such as, the modem hanging up.
The Emergency Log displays the total number of New Emergencies (unconfirmed) along with the number of Total Emergencies (A). This information is continuously updated as emergencies are received and confirmed. For further information regarding emergencies, refer to the Emergency Report section of the Reports chapter.

The Connection Log displays the status of the communication between the controller and CMS for Windows (B). You can connect and disconnect the job with this window. The Connection Time and Elapsed Time are also displayed, with the Elapsed Time continuously being updated.

The size of this window can be changed in two ways; it can be resized and minimized. When the window is minimized, the icon will show a picture of either a connected or disconnected cable along with the job name and number.
Modify System

Select **Modify System** from the **File** menu.

---

**Edit**

Highlight the job you wish to edit and click the **Edit** button. This window is identical to the Add System window with two exceptions. The job number is display only and the window contains previous and next buttons. Refer to the **Add System** section at the beginning of this chapter for further details.
Add

Click the **Add** button to add a new job to be monitored. This window is identical to the Add System window. This is just another way of accessing the Add feature. Refer to the **Add System** section at the beginning of this chapter for further details.

![Add System Window]

Delete

Highlight the job you wish to delete and click the **Delete** button. A prompt will be displayed confirming the deletion of the selected job.

**WARNING**: This will delete all data associated with this job from the database. Print any reports that you may need before selecting this option.
Highlight the job you wish to view and click the **View** button. This window is identical to the Add System window with two exceptions. This window is display only and contains previous and next buttons. Refer to the **Add System** section at the beginning of this chapter for further details.

![View System window](image)

Select **Close System** from the **File** menu to close the system window that is open and active. The active system window is the window that has its title bar highlighted.
Monitoring a Job

This chapter shows how to connect and disconnect from a job. Once connected to a job, all the available options are explained.

Connecting to a Job

You must connect to a job in order to view real time information and to update CMS for Windows' database. However, you do not have to connect to a job to view the reports.

There are a variety of ways to connect to a job. If you have a System window open, click on the Connect button. If you do not have a System window open, click on the Connect icon on the Iconbar or select Connect . . . from the Controller menu. The following window will be displayed.

Refer to the Open System section of the Setting Up a Job chapter for further details on the System window.

Once connected, all the options in the Controller menu are enabled, with the possible exception of Dispatcher and Group Status. These two options are only available on the Group M3 controller.
Before selecting an option from the **Controller** menu, make the job's System window active. This tells the **Controller** menu what job you would like information about.

**NOTE:** To make the System window active, click on that window. The title bar will then become highlighted.

**NOTE:** To see the last four jobs opened, select the **File** pull-down menu.

To see all the jobs that are currently open, select the **Window** pull-down menu.
Also, once connected, every time an emergency occurs the Emergency Event window will be displayed.

A description of the CMS Job Number, Name, and Building. If the CMS Job Number has not been created yet, the MCE Job Number and Name will be displayed.

NOTE:
To make the System window active, click on that window. The title bar will then become highlighted.

Disconnecting from a Job

Disconnecting from a job closes the connection between CMS for Windows and the elevator system.

There are a variety of ways to disconnect from a job. If you have a System window open, click on the Disconnect button, or select Disconnect from the Controller menu or click on the Disconnect icon on the Iconbar. The only way this will take effect is if the job’s System window is active. To make the System window active, click on that window.
The Real Time Clock window allows you to set the date and time on the elevator controller. This is important because all the system performance and event calendar entries are correlated to the real time clock.

The **Controller Clock** GroupBox always shows what the elevator controller clock is set to (A).

The **Set Controller Clock to** GroupBox is originally set to the same date and time as **Controller Clock**. If you modify **Set Controller Clock to** but wish to reset the date and time to the initial date and time displayed in the **Controller Clock** GroupBox, click on the **Copy>>** button. This will copy the date and time from the **Controller Clock** to the **Set Controller Clock to** GroupBox (B).

You can modify the year, month, day, hour, and minute (C, D, E, F and G). Month Name, Day Name, and Seconds are display only. The seconds will always remain the same as the **Controller Clock** seconds (H).
If you wish to synchronize the PC clock with the elevator controller clock, select the **PC Clock** CheckBox in the **Synchronize With** GroupBox. The date and time in **Set Controller Clock to** will continually update to coincide with the PC date and time. You will not be able to modify the date and time until you click the **Copy>>** button or unselect **PC Clock** in the **Synchronize With** GroupBox (K).

Click on the **Update** button to have **Controller Clock** updated to what is contained in **Set Controller Clock to**. The **Controller Clock** GroupBox will reflect the change to the date and time on the elevator controller (J).

Click on the **Close** button to close this window (I).
Controller CMS Parameters

The Controller CMS Parameters window allows you to view or modify the CMS for Windows parameters stored on the elevator system. The elevator system uses these parameters to transmit emergencies to CMS for Windows. Depending on the type of elevator controller, the appropriate window will be displayed. The window for an elevator controller with the CGP processor boards is shown first, followed by a window for an elevator controller without the CGP processor boards.

Controller with CGP Processor Boards

- **Activate or deactivate the emergency transmission option on the elevator system.** (B)
- **Corresponds to the number of times the elevator system attempts to report an emergency event to CMS for Windows.** (C)
- **Selects the elevator system's COM port.** (D)
- **If the elevator system is using a modem to communicate with CMS for Windows, this GroupBox allows you to specify the CMS for Windows computer's telephone number.** (E)
- **Display only. CMS job number and name.** (A)
- **Click here to close the window.** (F)
- **Click here to save the changes.** (G)
Controller without CGP Processor Boards

**Controller CMS Parameters**

- **Display Only. CMS Job number and name. (A)**
- **Click here to close the window. (F)**
- **Click here to save the changes. (G)**
- **Emergency Transmission Switch**
  - Activates or deactivates the emergency transmission option on the elevator system. (B)
  - Corresponds to the number of times the elevator system attempts to report an emergency event to CMS for Windows. (C)
  - Selects the elevator system's COM port. (D)

**NOTE:** Programmable controllers running MC-PA software versions 3.41 or higher don't use AT DT in the dial command and phone number (E) box.

The name and number of the CMS job for which the parameters are displayed appears at the top of the window (A).

If activated (set to On), the Emergency Transmission Switch allows the elevator system to transmit emergency events to CMS for Windows. When this parameter is deactivated (set to Off), no emergencies are transmitted to CMS for Windows (B). If you are experiencing difficulties entering the emergency phone number, highlight the whole edit box area, then, enter the new emergency phone number.

The Maximum Number of Attempts must be a number between 1 and 20. If the elevator system is unable to transmit an emergency message(s) after this Maximum Number of Attempts, the date, time, and reason for the failure will be logged into the Emergency Failed Transmissions file. For further information regarding this file, refer to Emergency Transmissions Errors Report section of the Reports chapter. The system will then stop trying to transmit the emergency
message(s). Once a new emergency occurs, the process will start over (C).

The communication device must be connected into the correct COM port on the elevator system (MC-MRS/ARS, MC-PA, or MC-RS boards). The particular COM port that the elevator system uses varies from system to system. With CGP Processor Boards The COM port can be either COM1, COM2, COM3, COM4 or any combination of them, if more than one elevator system is connected. Up to eight COM ports are allowed. If an emergency occurs, all COM ports with the Use for Transmission parameter set to Yes will be sent the emergency (D).

The elevator system calls the telephone number(s), only if Dial is set to Yes when it reports emergency events to CMS for Windows. Up to four telephone numbers are allowed.

Number allows for multiple CMS for Windows users to have access to the same emergency messages (E).

**WARNING:** If the Emergency Transmission Switch is set to Off, no COM ports will receive emergencies, regardless of how they are specified here. If the Emergency Transmission Switch is set to On, only COM ports that are set to Yes will receive emergencies.

**WARNING:** ‘AT DT’ must proceed the phone number (except controllers with MC-PA software ver. 3.41 or higher).

Click on the Close button to be prompted to save changes and close this window (F).

Click on the Save button to save any changes (G).
**Modem Parameters**

If the elevator controller is using a modem, the following parameters allow you to make the necessary changes regarding that modem. Click on the Close button to be prompted to save changes and close this window (F).

Click on the **Save** button to save any changes (G).

Click on the **Default** button to set the Modem Parameters equal to the default values (H).

**NOTE:** The Modem Parameters apply to the elevator system modem.

The name and number of the CMS job you are connected to is displayed at the top of the window (A).

The **Command Line** specifies the command that will be used by the elevator controller to get the modem’s attention (B). Usually, the Command Line is “+++” unless the modem specifies another string. The **Hang Up** string defines the string that will be sent to the modem to hang up after a connection (C). The **Reset** string defines the string that resets the modem (D). The **Initialization** string defines all the possible modem
commands that are needed to keep the modem in the “ready” state to answer incoming calls (E).

Controller Configuration

All information on the Controller Configuration window is display only. This window provides basic information about the elevator system. This information is based on the elevator specifications. The CMS and MCE job numbers and names are displayed at the top, along with the job type and number of cars and floors.

Use the instructions below for the following Controller Configuration windows.

- Click on the **Close** button to close this window (**A**).
- Click on the **Labels** button to view the car and floor labels (**B**).
- Click on the **Stops/Openings** button to view each car’s stops and openings (**C**).
- Click on the **Options** button to view all options (**D**).
- Click on the **COM Ports** button to view the COM ports (**E**).
- Click on the **Print** button to print what is displayed (**F**).
- Click on the **Help** button to go to the Help Menu (**I**).
The Labels window will be the default window displayed upon opening the Controller Configuration window.

The car labels will be displayed in the **Car** GroupBox along with their corresponding numbers (G). The floor numbers and their corresponding labels are displayed in the **Landing** GroupBox (H).
After clicking on the **Stops/Openings** button, the following window will be displayed.

The currently selected car label is displayed \((G)\).

The specified car’s stops and openings are displayed \((H)\).

A floor with an opening is referred to as \([ \_ ]\), whereas a floor without an opening is referred to as \([]\).
After clicking on the **Options** button, the following window will be displayed.

This window will display the options programmed on the elevator’s Main Processor (MP). The fire options (G) will be displayed along with any additional options (H).
After clicking on the **COM Ports** button, the following window will be displayed.

![COM Ports Window](image)

This window will display the elevator controller’s COM ports and their definitions (G).

There are 8 different devices. They are as follows:

- CRT (Monochrome)• Lobby CRT
- PC (MACS/CMS I)• Printer
- Lobby PC• Color CRT
- PC (CMS for Windows)• Color Lobby CRT

If there are no devices for a COM port, the device description will read Open.

There are 4 different media types. They are as follows:

- Direct (Serial Cable)
- Line Driver
- Modem
- Ethernet (The controller will still say connection with Serial Cable)
Dispatcher

The Dispatcher window is only available for Group M3 controllers.

Dispatching puts decision making capabilities into the right hands. CMS for Windows allows building managers to make decisions and tailor the dispatcher functions to their specific buildings.

Use the instructions below for the following Dispatcher windows.

- Click on the **Close** button to be prompted to save changes and close this window (**A**).
- Click on the **Save** button to save any changes (**B**).
- Click on the **System Parm.** button to view and modify the System Parameters (**C**).
- Click on the **Dispatching Config.** button to view and modify the Dispatching Configuration (**D**).
- Click on the **Lobby Up Peak Parm.** button to view and modify the Lobby Up Peak Parameters (**E**).
- Click on the **Print** button to print the information that is displayed on the window (**F**).
The System Parameters window is the first window in the dispatcher series. The building managers decide what kind of service is desirable for a specific building. It is at their discretion who gets faster service and who must wait longer.

The name and number of the CMS job you are connected to, along with the number of the currently active configuration, will be displayed at the top of the window (G). Please refer to the Dispatching Configuration section of this chapter for more information.

The Long Wait Hall Call Threshold Time is the time that constitutes excessive waiting time. The times are set per hall call type (front or rear), per direction (up or down), and per floor. These numbers are set according to the building needs, and they can be modified or changed when the traffic pattern in the building changes.

Once a hall call has been registered beyond the set Long Wait Hall Call Threshold, Minimize Maximum Waiting Time will take effect. This has
a tendency to not affect the mean waiting time, but to decrease the
number of hall calls that would have waited beyond their Long Wait Hall
Call Threshold Time. Note that these Long Wait Hall Call Threshold
Times may be used for priority service operation where a certain floor or
floors may require a higher priority of service than all other floors.
Severe degradation of service may occur when using priority service
because a car is removed from the group to service a priority call. Click
on the time to modify (H). A pop-up window will appear, as shown below.
The top floors in the up direction and the bottom floors in the down
direction are disabled (L).

![Pop-up window](image)

In case of a coincident call, the car that is selected to go to a particular
floor will respond to the call unless another car can better the response
time by the Coincident Call Preference Time (I).

The Reassignment Hysteresis Timer provides for stability in making a
commitment to a car for answering a hall call. A low value for this timer
would cause too many reassignments if two or more cars have very
closely calculated ETA (Estimated Time of Arrival) times. A high value
for this timer may increase the mean waiting time by "locking in"
assignments to a car when another car may have had a shorter ETA
time (J).

If the MG set of a car is shutdown, there has to be enough traffic to
justify the restart of the MG set. A low value for the Inactive Car Start
Up Delay Timer adds a lower value to the ETA calculation of a car, with
its MG set shutdown, to a hall call. A high value for this timer tends to
delay the assignment of hall calls to a car that has its MG set shutdown.
This value is added to the calculated ETA time for any car with its MG
shutdown, thereby making that car appear further away from the hall call
(K).

Click on the SpinControl to increase/decrease the value of all the timers.
The Dispatching Configuration window is the second window in the dispatcher series.

The name and number of the CMS job you are connected to is displayed at the top of the window (H).

Select the configuration you wish to modify from the DropDownListBox (J). The upper lefthand corner reads either **Programmed** or **Not Programmed** (I). Up to eight different configurations can be programmed. Each particular configuration can be actuated manually or automatically, through a timer table.
The **Parking Priority** GroupBox lets you choose the lobby floors and their priorities, as well as the non-lobby floors and their priorities. A lobby floor can have a floor priority of one, two, three, or four. A non-lobby floor can have a floor priority between and including five and twenty. **This Car Up Door Time** is the amount of time in seconds a car will keep its doors open. It is also the time the hall lantern will be illuminated after the car returns to the lobby. This option can be set to Open or Closed (K).

The setting of the **Long Wait Hall Call Threshold Changes** is similar to the setting of the **Long Wait Hall Call Threshold Time** found on the System Parameters window (L).

You can manually select the Mode of Operation. The Mode of Operation can have any one of the following values: Automatic, Balanced, Demand Down Peak, Demand Up Peak, or Lobby Up Peak (M).

The Parking Delay timers provide a delay before a car moves to park at the lobby or any other designated parking floors (N and O).

The Shuffle Delay timer provides a delay in replenishing the lobby floor when a car leaves the lobby (P).

The Lobby Car Removal Penalty Time timer adds a penalty to the non-lobby hall calls while calculating the ETA of a car which is parked at the lobby. This penalty time can prevent the dispatcher from removing a lobby car to service non-lobby hall calls (Q).

Select the configuration you wish to make as the current configuration. The value can be any configuration number that is programmed or ‘Timed.’ This is displayed on the other two dispatcher windows (R). The **Timer Table** button is only available on this dispatcher window. See the next section for further details (G).
### Timer Table

The Timer Table window allows you to program configurations on up to 16 different timers $(D)$. This may possibly affect the Current Configuration value. Access to this window is only found on the Dispatching Configuration window.

**Day** refers to the particular day(s) the configuration will be activated $(E)$. The day can be any one of the following: Mon., Tue., Wed., Thu., Fri., Sat., Sun., Mon. - Fri., and All.

- The particular day(s) the configuration will be activated $(E)$
- The timer number $(D)$
- The time when you want to activate the selected configuration for a particular day(s) $(F)$
- Any one programmed configuration $(H)$
- The time when you want to deactivate the selected configuration for a particular day(s) $(G)$
- Click here to save the changes and close this window $(A)$
- Turn timer on and off $(I)$
- Click here to print the timer table $(C)$
- Click here to close this window $(B)$

The **Start Time** consists of hours and minutes and is the time when you want to activate the selected configuration for a particular day(s) $(F)$.

The **End Time** consists of hours and minutes and is the time when you want to deactivate the selected configuration for a particular day(s) $(G)$.

The **Configuration Number** is any one programmed configuration $(H)$.
The **Timer Status** turns the timer on and off. Select On to turn the timer on. Select Off to turn the timer off (I).

Click on the **Save** button to save the changes and close this window (A).

Click on the **Cancel** button to close this window without saving the changes (B).

Click on the **Print** button to print the timer table (C).
The Lobby Up Peak window is the third window in the dispatcher series.

The name and number of the car's you are connected to along with the current configuration will be displayed at the top of the window (G). For more information about the current configuration, please refer to the Dispatching Configuration section in this chapter.

These variables are used to identify the traffic pattern in order to detect the lobby up peak.

If your system has load weighers installed in the cars, then you can set the Load Weigher Switch to the On position. The Load Weigher Switch can be turned On or Off. If the Load Weigher Switch is Off, the system will stop monitoring load in the car at the lobby floor(s). By default this switch is set to On (H).
The Monitoring Interval is the time interval within which a fixed number of consecutive cars leave the lobby floor. The quantity of cars that leave the lobby during this interval is used to put the group dispatcher into the lobby up peak mode. This interval can be anywhere between ten seconds and five minutes. By default, it is set to 45 seconds (J).

Monitoring the Number of Car Calls involves monitoring the number of car calls which are registered at the lobby floor. Car call monitoring is a useful software load indicator in the absence of hardware load weighers. Counting the number of car calls that are registered at the lobby floor is a good estimate of determining the load in the car.

The Car Call Switch can be turned On or Off. When in the Off position, the system will stop monitoring the number of car calls registered at the lobby floor(s). By default, this switch is set to Off (K).

The Number of Car Calls parameter specifies the minimum number of car calls that need to be registered before that car is considered loaded. The valid range of this variable is one through the total number of floors above the lobby floor. By default, it is set to half of the total number of floors in the building (L).

The Number of Cars to Depart from Lobby specifies the number of consecutive cars that should leave the lobby floor before the traffic identification module puts the dispatcher into the lobby up peak mode of operation. By default, this parameter is set to two (valid range is between 1 and 12) (I).

The Mode of Operation Change Delay is provided to change the mode of operation. The elevator controller determines heavy incoming traffic at the lobby which enables the group dispatcher to operate in the lobby up peak mode. Once the elevator controller determines that traffic demand no longer needs the dispatcher to operate in the lobby up peak mode, the group dispatcher returns to the balanced mode (default mode). There is no delay in getting into the lobby up peak mode, but this delay is used in getting out of the lobby up peak mode. This delay is also used for getting into and getting out of Demand Down Peak mode and Demand Up Peak mode. This delay can be set to anywhere between one and 99 seconds. By default, this delay is 20 seconds (M).
Variables for Lobby Up Peak

Two floors can be selected to be lobby floors \( M \).

The Degree of LUP (Lobby Up Peak) can be programmed to either Low or High. This determines how many cars should be dispatched to the lobby floor in the event of an automatic detection of lobby up peak mode or manual selection of lobby up peak mode. For more information refer to the LUP Classification Table shown below to determine how many cars should be sent in the event of lobby up peak \( O \).

**Lobby Up Peak Classification Table**

<table>
<thead>
<tr>
<th>DEGREE OF LOBBY UP PEAK</th>
<th>NUMBER OF LOBBIES IN LUP</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Low</td>
<td>(Cars in Group)/2</td>
</tr>
<tr>
<td>High</td>
<td>(Cars in Group - 1)</td>
</tr>
</tbody>
</table>

The Dispatch Interval Time is the amount of time a car should keep its doors open at the lobby floor during LUP. This variable can be programmed to ‘close,’ or open for one to 199 seconds. By default, this parameter is set to 20 seconds \( P \).
Car Operating Parameters

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

**Group M3**
*(Adjustable for connected cars and display only for cars not connected.)*

The Car Operating Parameters window provides field programmable timing functions for specific cars. Depending on your type of elevator controller, the appropriate window will be displayed. There are three different types of windows: Group M3, Simplex/Duplex, and PHC/PTC.

Click on the **Close** button to be prompted to save any changes and close this window (A).

Click on the **Save** button to save any changes and keep this window open (B).
Simplex/Duplex
(There is no MG Shutdown Time and Calculated Car Parameters.)

PHC/PTC
(All parameters are display only.)
Keyboard Control for Elevators

Keyboard Control for Elevators (KCE) is an integrated CMS feature that allows users to control the operation of an elevator from a remote PC (CMS station). KCE enables users to initiate services such as Independent Service, Out of Service, Swing Operation, etc. from a remote CMS station.

**NOTE:** KCE is available only for Group M3 controllers equipped with the CGP processor boards.

The controller must be programmed with the KCE option which allows the cars to respond to KCE commands issued by CMS. If the KCE option is programmed on the controller, you will be able to disable it for all cars or each individual car. To disable KCE for all cars, turn OFF the KCE option from the group controller’s swing panel. To disable KCE for an individual car, turn OFF the KCE option from the desired car controller’s swing panel. If you disable KCE for an individual car, other cars in the group will continue to service KCE commands normally.

You have to be connected to the controller before you can access the KCE features. To access the KCE features, select **Keyboard Control (KCE)** from the **Controller** menu. The following window will appear.

![Available KCE Features Window]

This window lists the KCE features available for the controller you are connected to. Currently, there are four features available:

- Independent Service
- Car to Lobby
- Out Of Service
- Swing Operation
To view information on a specific feature, select the desired KCE feature, then click on the **Select** button.

Each KCE Feature window contains a list of available features (A). Click on the down arrow of the **Keyboard Control Feature** DropDownListBox to switch to another KCE feature (B). The parameters required to control the selected feature are also displayed (C). For a detailed description of the parameters of each feature, please refer to the desired feature description later in this section.

Click on the **Save** button to issue the feature’s commands (E). Click on the **Reload** button to retrieve the feature’s current status from the controller (F). Click on the **Show** CheckBox in the **Hoistway** GroupBox to view the car’s hoistway display (G). The hoistway will appear on the right side of the window.

It is only possible to view the Hoistway display of one car at a time. To view the Hoistway display of a different car, click on the down arrow of the **Car** option in the **Hoistway** GroupBox (I). If you are connected to a
group controller, clicking on the hall call buttons will register hall calls for the group and not for the displayed car (J).

**NOTE:** The Hoistway display gives you the car’s current status, position, and the state of the doors. However, it might slow the communication between CMS and the controller. Hide the Hoistway display if it is not required.

To hide the hoistway display, click on the Hoistway Show check box (H). To close the window, click on the Close button (D).
Independent Service

The Independent Service feature allows you to place one or more cars on “Independent Service”. A car on Independent Service shall operate according to the MCE Independent Service specification. The KCE - Independent Service window displays the parameters required to place (or remove) a car on Independent Service. The window will also display the car’s current (physical) Independent Service status for each car in the system.

There are two ways of placing a car on Independent Service, through the Independent Service key switch input or through Keyboard Control (KCE) available from the CMS station. The Car’s Physical Status depends on the status of these two inputs. There are 6 different possibilities for the Car’s Physical Status (E). They are as follows:

- A: On - Off: Car Not Connected
- B: Off - On: Car Not Connected
- C: Off - Off: Car Not Connected
- D: On - Off: ON - through KCE
- E: Off - On: Car Not Connected
- F: Off - Off: Car Not Connected
<table>
<thead>
<tr>
<th>Physical Status</th>
<th>Key Switch</th>
<th>KCE</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>The car is NOT on Independent Service.</td>
</tr>
<tr>
<td>ON - Through KCE</td>
<td>OFF</td>
<td>ON</td>
<td>The car was placed on Independent Service through KCE from CMS.</td>
</tr>
<tr>
<td>ON - Through Key Switch</td>
<td>ON</td>
<td>OFF</td>
<td>The car was placed on Independent Service through the hardware key switch.</td>
</tr>
<tr>
<td>ON - KCE Feature Disabled</td>
<td>ON</td>
<td>Blocked</td>
<td>The car is on Independent Service through the key switch, however, the KCE feature has been blocked from the swing panel.</td>
</tr>
<tr>
<td>OFF - KCE Feature Disabled</td>
<td>OFF</td>
<td>Blocked</td>
<td>The car is NOT on Independent Service through the key switch, however, the KCE feature has been blocked from the swing panel.</td>
</tr>
<tr>
<td>Car Not Connected</td>
<td>N/A</td>
<td>N/A</td>
<td>The car is not connected to the group.</td>
</tr>
</tbody>
</table>

The following Independent Service parameters, for each car, are available from this window:

- The Independent Service Status
- The Destination Floor
- The Cancel Car Calls Option

To change a car’s Independent Service status through KCE, click on the appropriate Status option (On or Off) for the desired car (B).

**NOTE:** You will only be able to take a car out of Independent Service through KCE, if the car was put on Independent Service through KCE.

To send the car to a particular floor before placing it on Independent Service, select the car’s destination floor from the Floor list (C). If you want the car to cancel any existing car calls before going on Independent Service, select Yes from the Cancel Car Calls option,
otherwise, select No (D). The destination floor and the cancel car calls option are only available when placing the car on Independent Service.

Once you have finished changing the Independent Service parameters, click on the Save button (H). This will issue the Independent Service commands to all the cars you have modified. After CMS issues the Independent Service commands, it will retrieve the car’s current status.

Click on the Reload button to retrieve the feature’s current status from the controller (G). Click on the Show CheckBox in the Hoistway GroupBox to view the car’s hoistway display (F).

To switch to another KCE feature, click on the down arrow of the Keyboard Control Feature DropDownListBox to display a list of the available features (A). Then select the desired feature. To close the window, click on the Close button (I).
Car To Lobby

The Car to Lobby feature allows you to capture a car and send it to a particular floor. The KCE - Car to Lobby window displays the parameters required to place (or remove) a car on Car to Lobby. The window will also display the car’s current (physical) Car to Lobby status for each car in the system.

There are two ways of placing a car on Car to Lobby, through the Car to Lobby key switch input or through Keyboard Control (KCE) available from the CMS station. The Car’s Physical Status depends on the status of these two inputs. There are 6 different possibilities for the Car’s Physical Status (F). They are as follows:
### Physical Status Key

<table>
<thead>
<tr>
<th>Physical Status</th>
<th>Key Switch</th>
<th>KCE</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>The car is NOT on Car to Lobby.</td>
</tr>
<tr>
<td>ON - Through KCE</td>
<td>OFF</td>
<td>ON</td>
<td>The car was placed on Car to Lobby through KCE from CMS.</td>
</tr>
<tr>
<td>ON - Through Key Switch</td>
<td>ON</td>
<td>OFF</td>
<td>The car was placed on Car to Lobby through the hardware key switch.</td>
</tr>
<tr>
<td>ON - KCE Feature Disabled</td>
<td>ON</td>
<td>Blocked</td>
<td>The car is on Car to Lobby through the key switch, however, the KCE feature has been blocked from the swing panel.</td>
</tr>
<tr>
<td>OFF - KCE Feature Disabled</td>
<td>OFF</td>
<td>Blocked</td>
<td>The car is NOT on Car to Lobby through the key switch, however, the KCE feature has been blocked from the swing panel.</td>
</tr>
<tr>
<td>Car Not Connected</td>
<td>N/A</td>
<td>N/A</td>
<td>The car is not connected to the group.</td>
</tr>
</tbody>
</table>

The following Car to Lobby parameters, for each car, are available from this window:

- The Car to Lobby status
- The Door Status
- The Destination Floor
- The Cancel Car Calls Option

To change a car’s Car to Lobby status through KCE, click on the appropriate **Status** option (On or Off) for the desired car *(B)*.

To send the car to a particular floor before placing it on Car to Lobby, select the car’s destination floor from the **Floor** list *(D)*. To specify the car’s door operation when the car reaches the destination floor, select the appropriate door status (Open, Closed, Cycle) from the **Door Status** list *(C)*. If you want the car to cancel any existing car calls before going on Car to Lobby, select Yes from the **Cancel Car Calls** option, otherwise, select No *(E)*. The destination floor, door status, and the cancel car calls options are only available when placing the car on Car to Lobby.

Once you have finished changing the Car to Lobby parameters, click on the **Save** button *(I)*. This will issue the Car to Lobby commands to all the
cars you have modified. After CMS issues the Car to Lobby commands, it will retrieve the car’s current status.

Click on the **Reload** button to retrieve the feature’s current status from the controller *(H)*. Click on the **Show** CheckBox in the **Hoistway** GroupBox to view the car’s hoistway display *(G)*.

To switch to another KCE feature, click on the down arrow of the **Keyboard Control Feature** DropDownListBox to display a list of the available features *(A)*. Then select the desired feature. To close the window click on the **Close** button *(J)*.
The Out of Service feature allows you to place a car on “Out of Service.” The KCE - Out of Service window displays the parameters required to place (or remove) a car on Out of Service. The window will also display the car’s current (physical) Out of Service status for each car in the system.

There are two ways of placing a car on Out of Service, through the Out of Service key switch input or through Keyboard Control (KCE) available from the CMS station. The **Car’s Physical Status** depends on the status of these two inputs. There are 6 different possibilities for the **Car’s Physical Status** (F). They are as follows:

<table>
<thead>
<tr>
<th>Car</th>
<th>Door Status</th>
<th>Floor</th>
<th>Cancel Car Calls</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>B</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>C</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>D</td>
<td>Cycle</td>
<td>3</td>
<td>Yes/No</td>
</tr>
</tbody>
</table>

The Out of Service window displays the parameters required to place (or remove) a car on Out of Service. The window will also display the car’s current (physical) Out of Service status for each car in the system.

- **(A)** Click here to select a different KCE feature.
- **(B)** Select the car’s Out Of Service status.
- **(C)** Select the desired door status.
- **(D)** Select the destination floor.
- **(E)** Select Yes to cancel existing car calls. Select No to retain existing car calls.
- **(F)** Displays the car’s physical Out Of Service status.
- **(G)** Click here to view the hoistway.
- **(H)** Click here to re-display the feature’s parameters.
- **(I)** Click here to send the Out Of Service parameters to the controller.
- **(J)** Click here to close the window.
Physical Status | Key Switch | KCE | Comments
---|---|---|---
OFF | OFF | OFF | The car is NOT on Out of Service.
ON - Through KCE | OFF | ON | The car was placed on Out of Service through KCE from CMS.
ON - Through Key Switch | ON | OFF | The car was placed on Out of Service through the hardware key switch.
ON - KCE Feature Disabled | ON | Blocked | The car is on Out of Service through the key switch, however, the KCE feature has been blocked from the swing panel.
OFF - KCE Feature Disabled | OFF | Blocked | The car is NOT on Out of Service through the key switch, however, the KCE feature has been blocked from the swing panel.
Car Not Connected | N/A | N/A | The car is not connected to the group.

The following Out of Service parameters, for each car, are available from this window:

- The Out of Service status
- The Door Status
- The Destination Floor
- The Cancel Car Calls Option

To change a car’s Out of Service status through KCE, click on the appropriate Status option (On or Off) for the desired car (B).

To send the car to a particular floor before placing it on Out of Service, select the car’s destination floor from the Floor list (D). To specify the car’s door operation when the car reaches the destination floor, select the appropriate door status (Open, Closed, Cycle) from the Door Status list (C). If you want the car to cancel any existing car calls before going on Out of Service, select Yes from the Cancel Car Calls option, otherwise, select No (E). The destination floor, door status, and the cancel car calls options are only available when placing the car on Out of Service.
Once you have finished changing the Out of Service parameters, click on the **Save** button (**I**). This will issue the Out of Service commands to all the cars you have modified. After CMS issues the Out of Service commands, it will retrieve the car’s current status.

Click on the **Reload** button to retrieve the feature’s current status from the controller (**H**). Click on the **Show** CheckBox in the **Hoistway** GroupBox to view the car’s hoistway display (**G**).

To switch to another KCE feature, click on the down arrow of the **Keyboard Control Feature** DropDownListBox to display a list of the available features (**A**). Then select the desired feature. To close the window, click on the **Close** button (**J**).
The Swing Operation feature allows you to place a car on “Swing Operation.” The KCE - Swing Operation window displays the parameters required to place (or remove) a car on Swing Operation. The window will also display the car’s current (physical) Swing Operation status for each car in the system.

There are two ways of placing a car on Swing Operation, through the Swing Operation key switch input or through Keyboard Control (KCE) available from the CMS station. The **Car’s Physical Status** depends on the status of these two inputs. There are 7 different possibilities for the **Car’s Physical Status (C)**. They are as follows:
<table>
<thead>
<tr>
<th>Physical Status</th>
<th>Key Switch</th>
<th>KCE</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>The car is NOT on Swing Operation.</td>
</tr>
<tr>
<td>ON - Through KCE</td>
<td>OFF</td>
<td>ON</td>
<td>The car was placed on Swing Operation through KCE from CMS.</td>
</tr>
<tr>
<td>ON - Through Key Switch</td>
<td>ON</td>
<td>OFF</td>
<td>The car was placed on Swing Operation through the hardware key switch.</td>
</tr>
<tr>
<td>ON - KCE Feature Disabled</td>
<td>ON</td>
<td>Blocked</td>
<td>The car is on Swing Operation through the key switch, however, the KCE feature has been blocked from the swing panel.</td>
</tr>
<tr>
<td>OFF - KCE Feature Disabled</td>
<td>OFF</td>
<td>Blocked</td>
<td>The car is NOT on Swing Operation through the key switch, however, the KCE feature has been blocked from the swing panel.</td>
</tr>
<tr>
<td>Service Not Available</td>
<td>N/A</td>
<td>N/A</td>
<td>The car is not programmed to accept Swing Operation.</td>
</tr>
<tr>
<td>Car Not Connected</td>
<td>N/A</td>
<td>N/A</td>
<td>The car is not connected to the group.</td>
</tr>
</tbody>
</table>

Only the Swing Operation status parameter is available for the Swing Operation feature.

To change a car’s Swing Operation status through KCE, click on the appropriate **Status** option (On or Off) for the desired car *(B)*.

Once you have finished changing the Swing Operation parameters, click on the **Save** button *(F)*. This will issue the Swing Operation commands to all the cars you have modified. After CMS issues the Swing Operation commands, it will retrieve the car’s current status.

To switch to another KCE feature, click on the down arrow of the **Keyboard Control Feature** DropDownListBox to display a list of the available features *(A)*. Then select the desired feature. To close the window, click on the **Close** button *(G)*.
Programmable Events

Programmable Events is an integrated CMS feature that allows you to specify the action the controller will take when it encounters an event.

**NOTE:** You must be connected to the controller before you can access the Programmable Events feature.

Select **Programmable Events** from the **Controller** menu to display the Programmable Events window.

This window displays a list of all the events available on the controller and the action set for each of them. The action for an event may be set to NONE, LOG and LOG & TRIGGER. When an event occurs, the controller responds according to the option set for that event.

The following table summarizes the available event actions and the controller response when it encounters the specified event.
<table>
<thead>
<tr>
<th>ACTION</th>
<th>CONTROLLER RESPONSE</th>
</tr>
</thead>
<tbody>
<tr>
<td>NONE</td>
<td>No action will be taken.</td>
</tr>
<tr>
<td>LOG</td>
<td>The event will be stored in the event calendar on the controller. Please refer to the Update Reports subsection in this chapter for more details on updating the event calendar data file for CMS.</td>
</tr>
<tr>
<td>LOG &amp; TRIGGER</td>
<td>The event will be stored in the event calendar on the controller and will be called out as an emergency event to the CMS station.</td>
</tr>
</tbody>
</table>

To change the action of an event, find the event in the list and then select the corresponding action. When you finish changing the actions of all the events, click on the **Save** button to save the settings in the controller.

Click on the **Close** button to close this window and return to the main window.
The Hoistway window displays a graphic representation of the elevator system. It includes each car's position, door status, direction of travel, status of operation, and the number of registered car calls. The window also displays the up and down hall calls and their assignments.

The car labels are displayed at the top of the window (E). The floor labels are displayed at the center of the window (N).
You can resize and move the Hoistway window. When you close the Hoistway window, the window’s size will be saved to be used for the next time that you display the hoistway.

The Hoistway window displays each car as a box moving up and down the hoistway. Each car’s door status is displayed within the car box, either open, opening, closed, or closing (J).

An M3 Group controller also displays the Estimated Time of Arrival (ETA) and the Wait Time (WT) for each hall call. If both front and rear hall calls are registered for a particular landing, the front ETA and WT are displayed (G and H).

Registered car calls are represented by a circle displayed in the cars hoistway (A and I). To display the Car Operating Panel and register a car call, double-click on a specific car’s hoistway. Click on the floor label to register a car call. There will be a short delay, while CMS for Windows notifies the elevator controller of the request and the elevator controller take’s action.

Registered hall calls are indicated by changing the color of the up or down hall call button (K and L). To register a hall call, click one of the up or down call buttons. There will be a short delay while CMS for Windows notifies the elevator controller of the request and the elevator controller take’s action.

Group dispatching controllers include the assigned hall call information. Up (↑) and Down (↓) arrows in the car’s hoistway indicate that a hall call has been assigned to that particular car (B and M).
The group to car communication status and direction is also displayed on top of the individual car hoistway. Listed below are the different communication statuses and directions that can be displayed (D).

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NC</td>
<td>No Communication</td>
</tr>
<tr>
<td>OUT</td>
<td>Car Out of Service</td>
</tr>
<tr>
<td>UP</td>
<td>Car Running Up</td>
</tr>
<tr>
<td>DN</td>
<td>Car Running Down</td>
</tr>
<tr>
<td>IN</td>
<td>Car is In Service - No Direction</td>
</tr>
<tr>
<td>P</td>
<td>Car is parked</td>
</tr>
<tr>
<td>ON</td>
<td>Normal Operation - MG set, if any, is ON</td>
</tr>
<tr>
<td>OFF</td>
<td>MG set is OFF</td>
</tr>
</tbody>
</table>

The controller’s date and time are displayed on the menu bar in the upper right corner of the window (F). To hide the menu bar or to show/hide the ETA and wait times, use the Setup menu (C).
The Car Flags window displays selected internally generated car flags for diagnostics purposes. The specific car's identifier (label) is displayed on the window's title. The individual car flag LED will light up when the car flag is on. This window will show the real time status of the car flags as they occur on the controller. As the mouse moves over the car flags, a description will be displayed at the bottom.
Car Status

The Car Status window displays the cars’ detailed status. A car status box will be displayed for each car in the system. Up to 10 statuses can be displayed at one time. They are displayed in decreasing order of importance. The first message displayed is the most important, the next is less important, and so on.

NOTE: Some of these statuses may not pertain to your elevator system.

- Alarm - No Car Movement
- Alarm - No Door Zone
- Anti-nuisance - LLW
- Attendant Service
- Automatic Operation
- Bottom Floor Demand
- Brake Lifted
- Car Not Responding
- Car On Emergency Power
- Earthquake Operation
- Emergency Power, Car Off

The following is a list of all the possible statuses. Refer to Appendix A for further information.
- Fire Phase 1 (Main)
- Fire Phase 1 (Alternate)
- Fire Phase 2
- Hall Call ByPass - HLW
- Hospital Emergency
- In Car Stop Switch
- Independent Service
- In Service
- Inspection Access
- Leveling
- LSA Movement Failure
- MG Shut Down
- Motor Limit Timer Elapsed
- Nudging
- Off Line
- Out of Service
- Over Travel
- Parked
- Photo Eye Failure
- Re-leveling
- Roll Back
- Running Down
- Running Up
- Safety Edge Failure
- Safety String Open
- Speed Out of Limits
- Swing Car Operation
- Timed Out of Service
- Top Floor Demand
The Group Status window displays the current operation status of the group. This window is only available for Group M3 controllers. Listed below are the group statuses monitored by CMS for Windows and their descriptions.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fire Service Main</td>
<td>System is on Fire Service. Cars return to Main Fire floor.</td>
</tr>
<tr>
<td>Fire Service Alternate</td>
<td>System is on Fire Service. Cars return to Alternate Fire floor.</td>
</tr>
<tr>
<td>Hall Call Bus Fuse Blown</td>
<td>2H (Hall Call) bus fuse is blown.</td>
</tr>
<tr>
<td>System Out of Service</td>
<td>All the cars are out of service.</td>
</tr>
<tr>
<td>Security Activated</td>
<td>The system uses security.</td>
</tr>
<tr>
<td>Emergency Power</td>
<td>The system is on emergency power.</td>
</tr>
</tbody>
</table>

**Traffic**

<table>
<thead>
<tr>
<th>Traffic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lobby Up Peak</td>
<td>Up peak from lobby(s)</td>
</tr>
<tr>
<td>Demand Up Peak</td>
<td>More up calls then down calls</td>
</tr>
<tr>
<td>Demand Down Peak</td>
<td>More down calls then up calls</td>
</tr>
<tr>
<td>Balanced</td>
<td>Two-way traffic</td>
</tr>
</tbody>
</table>
Options

Update Reports

The Update Reports option allows you to update any jobs that you are currently connected to. The Update Reports window displayed is exactly the same as the Auto-Update settings window, with the exception of the absence of the bottom fields.

Auto-Update

The Auto-Update option allows you to manually start the auto-update procedure. This procedure is normally automatically run at the time specified in the Auto-Update Setup window, but can be run here manually using this option. For further information regarding the Auto-Update Setup window, refer to the Getting Started chapter.
Create Maintenance Log

The Maintenance Log window allows you to create a new maintenance log record. All the maintenance log records will be available through the Maintenance Log report.

To create a maintenance log, you must first enter a valid mechanic ID (A). If you have forgotten your mechanic ID, click on the Browse button to display a list of registered mechanics (B). Select the log action type, either Log In or Log Out (C). The Log In action indicates that you are starting maintenance work. The Log Out action indicates that you have completed the maintenance work.

Finally, enter any comments you have regarding the work to be performed or completed (E).

The current date and time of the log are displayed and cannot be changed (D).

To save the entered information and create the maintenance log, click on the Save button (F). To abandon the changes and close the window, click on the Cancel button (G).
MCE’s elevator security options, Basic Security with CRT and Access Control for Elevators (ACE) are programmed using a CRT terminal or a PC running the CMS software. The Security Interface Software (SIS), which can be accessed from the CMS Options menu, is used to program the elevator security parameters using a PC.

This chapter describes all the report and report options available in CMS for Windows. For a complete list when generating Reports make sure the following Report Preferences are set.

Go to: **File, Preferences, Report Preferences** as shown below.

Set the Report Preferences to recommended minimum as shown below.
Some report windows contain the same functionality. These windows are explained on the following pages.

**Cars In Service**

The Cars In Service window is display only. Each car is displayed, along with the percentage of time the car was in service.

Use the right scroll bar to scroll through various days and times.

NOTE: In order to update the Cars In Service data, the Standard Hall Call Distribution report must be updated through Update Reports or **Auto-Update** from the **Options** menu.
**Graph Type**

The Graph Type window displays the different types of graphs that are available. This is where you would select the graph type for a graphical report.

Just click on a graph to select it.

To save your selection and close this window, click on the **Close** button (A).

To close this window without saving your selection, click on the **Cancel** button (B).

**Search**

The Search window is used to search for a specific string pattern. This search pattern corresponds to the description contained in the report.

**Enter the text you wish to search for.** (A)

**Search result message display area.** (B)
The Sort window is used to sort the fields in a report. You can specify up to eight sort levels.

Either type or select the field you wish to sort on. (A) Click on the RadioButton to select the field’s sort in either Ascending or Descending order. (B) Click here to save the sort and close the window. (C) Click here to cancel any changes that were made. (D) Click here to add another sort level. (E) Click here to delete the current sort level. (F) Click here to Insert a new sort level. (G)

Either click on the arrow to display a list of fields to select from or directly enter the name of the field in the SingleLineEdit (A). This field can be sorted in either ascending or descending order (B).

To add a new sort level, click on the Add button (E). To insert a sort level between two existing levels, first select the level to insert, then click on the Insert button (G).

To delete a level, select the level you want to delete, then click on the Delete button (F).

To close the window and save the sort order, click on the Close button (C). To ignore all the changes and close the window, click on the Cancel button (D).
Emergency Report

The Info @ Bottom and Grid Emergency reports display all the emergencies that have occurred. The Info @ Bottom report shows if the emergency was confirmed. The Grid report allows you to drag the columns to resize or eliminate specific ones.

This tool can be customized to fit your needs. You can specify the time frame for which the information will be displayed (B). This information is displayed at the bottom of the window (D).

Click on the Print button to send a copy of this report to your printer (C).
Click on the Close button to close this window (A).
NOTE: You do not have to be connected in order to view the report. You do need to be connected to receive the emergencies.

**Date and Time**

The Date and Time window is used to display the data for the period you wish to view. The period will not be saved session to session. Once the report window is closed, these changes will be lost.

- Click here to change the start date.  
- Click here to change the end date.
- Click here to change the start time.
- Click here to change the end time.

Click here to save any changes and close this window.  
Click here to close this window without saving the changes.
In order to change the period, select the start date by clicking on the down arrow and highlighting the date that you wish the report to begin (A). Select the start time by clicking on the up and down arrows (B). The same holds true for the end date and time (C and D).

To save your changes and close this window, click the Close button (E). To cancel your changes and close this window, click the Cancel button (F).

**Select**

The Select window is used to filter specific data in the report. These selections will be saved from session to session.

The car selection is valid if only one job has been selected. If one job is selected, highlight the cars that you want included (A). At least one car must be highlighted. To select or unselect all cars at one time, click on the Select All and Unselect All buttons, respectively (B and C).
Highlight the jobs you want included in the report (D). To select or unselect all jobs at one time, click on the Select All and Unselect All buttons, respectively (E and F).

Highlight the emergencies you want included in the report (G). To select or unselect all emergencies at one time, click on the Select All and Unselect All buttons, respectively (H and I).

Select the confirmation option you want to include in the report (J). To include all emergencies, click the Both option.

To save your changes and close this window, click the Close button (K). To close this window without saving your changes, click the Cancel button (L).

Preferences

The Preferences window lets you select the sort and indicators. These selections will be saved from session to session.

To change the sort that is displayed on this window, click on the Sort button (A). For further information regarding the sort, refer to the Common Report Windows section at the beginning of this chapter.
When you would like to flag specific emergencies, begin by selecting the indicator that you wish to use (B). The indicator is what is displayed to the right of the report. The indicator can be an Arrow, Hand, Green Flag, or Red Flag. Next you will need to highlight the emergencies that you would like to have indicated (C). To select or unselect all emergencies at one time, click on the Select All and Unselect All buttons, respectively (D and E).

To save your changes and close this window, click the Close button (F). To close this window without saving your changes, click the Cancel button (G).

**Summary**

The Summary window displays summarized information about the Emergency report. The summary filters the data the same way as the report.

This window displays the number of emergencies per job (A). This information is sorted based on the job number. Also, this window displays the total number of emergencies for each car in the system (B). Only cars that have emergencies will be displayed. Click on the Print button to print this window (D).

Click on the Close button to close this window (C).
Cars In Service

For further information, refer to the Common Report Windows section at the beginning of this chapter.

Sample Analysis

The sample report shown at the beginning of this section shows emergencies for job number 3333 that have occurred between August 1, 1995 00:00 and August 3, 1995 23:59.

This report is sorted by the emergency Received Date and Time in descending order.

Emergency Transmission Errors Report

The Emergency Transmission Errors report displays all the errors that have occurred when the elevator controller has failed to transmit emergencies.

The data and time that the transmission error occurred.

Select the job that you wish to view the report for.

The description of the transmission error.

The number of attempts that was made to transmit the emergency.

Click here to close the window. (A)

Click here to change the date and time. (B)

Click here to filter the data on the report. (C)

Click here to set the preferences. (D)

Click here to view the Cars In Service. (E)

Click here to display a summary version of this report. (F)

Click here to search for a specific transmission error. (G)

Click here to print the report. (H)

The Date, Time, and Sort options that you selected will be displayed here so that it is not necessary to go back into those windows to see what your selections were. (I)
This tool can be customized to fit your needs. You can specify the time frame for which the information will be displayed (B). This information is displayed at the bottom of the window (I). You can also specify the emergency transmission errors to be displayed (C). This allows you to focus your monitoring on specific errors. Up to eight levels of sorting can be done in ascending or descending order (D). The sort is also displayed at the bottom of the window (I). Also provided is a summary report showing totals by emergency transmission errors (F). Click on the search button to search for a specific string (G). To view the percentage of cars in service, click on the **Cars In Service** button (E). For more information about cars in service, refer to the **Common Reports Windows** section at the beginning of this chapter.

Upon opening this window, the first row will be highlighted. Use the scroll bar to the right of the report to view additional rows not displayed. The scroll bar will not appear if all the data fits on one page.

Click on the **Print** button to send a copy of this report to your printer (H).

Click on the **Close** button to close this window (A).

---

**NOTE:** In order to view any data for this report, the Emergency Failed Transmissions report must first be updated through Update Reports or **Auto-Update** from the **Options** menu.

**NOTE:** You do not have to be connected in order to view the report.
**Date and Time**

The Date and Time window is used to display the data for the period you wish to view. The period will not be saved session to session. Once the report window is closed, these changes will be lost.

In order to change the period, select the start date by clicking on the down arrow and highlighting the date that you wish the report to begin (A). Select the start time by clicking on the up and down arrows (B). The same holds true for the end date and time (C and D).

To save your changes and close this window, click the **Close** button (E). To cancel your changes and close this window, click the **Cancel** button (F).

**Select**

The Select window is used to filter specific data in the report. These selections will be saved from session to session.

Highlight the emergency transmission error to be included in the report. (A)

Click here to select all emergency transmission errors. (B)  
Click here to unselect all emergency transmission errors. (C)

Click here to save any changes and close this window. (D)

Click here to close this window without saving your changes. (E)
Highlight the emergency transmission errors you want included in the report (A). To select or unselect all emergencies at one time, click on the Select All and Unselect All buttons, respectively (B and C).

To save your changes and close this window, click the Close button (D). To close this window without saving your changes, click the Cancel button (E).

Preferences

The Preferences window lets you select the sort and indicators. These selections will be saved from session to session.

To change the sort that is displayed on this window, click on the Sort button (A). For further information regarding the sort, refer to the Common Report Windows section at the beginning of this chapter.

When you would like to flag specific emergency transmission errors, begin by selecting the indicator that you wish to use (B). The indicator is what is displayed to the right of the report. The indicator can be an Arrow, Hand, Green Flag, or Red Flag. Next, highlight the emergency transmission errors that you would like to have indicated (C). To select or unselect all emergency transmission errors at one time, click on the Select All and Unselect All buttons, respectively (D and E).
To save your changes and close this window, click the **Close** button (**F**). To close this window without saving your changes, click the **Cancel** button (**G**).

---

**Cars In Service**

For further information, refer to the **Common Report Windows** section at the beginning of this chapter.

---

**Summary**

The Summary window displays summarized information about the report. The summary filters the data the same way as the report.

---

**Search**

For further information, refer to the **Common Report Windows** section at the beginning of this chapter.

---

**Sample Analysis**

The sample report shown at the beginning of this section shows different emergency transmission errors that have occurred between August 10, 1995 00:00 and August 11, 1995 23:59 for job 3333 Test Tower. One emergency transmission error, ‘Invalid modem initialization string,’ occurred twice in this two-day period. Only one attempt was made each time.

This report is sorted by Date and Time in descending order.
Hall Call Analysis

The Hall Call Analysis report displays the hour’s hall calls overview for a specific job. If you wish to view a different job, click on the down arrow in the Selected Job DropDownListBox and highlight a job (A). This report consists of the number of hall calls answered within specified intervals for each landing and direction. It also includes the total number of hall calls and percentage of cars in service for that hour.

This tool can be customized to fit your needs. You can specify the time frame for which the information will be displayed (C). This information is displayed at the bottom of the window (H). A variety of intervals can be defined in seconds (D). The Up, Down, or both reports may be viewed at the same time or individually (F). To view the percentage of cars in service, click on the Cars In Service button (E). For more information about cars in service, refer to the Common Reports Window section at the beginning of this chapter.
Click on the **Print** button to send a copy of this report to the printer (G).

Click on the **Close** button to close this window (B).

**NOTE:** In order to view any data for this report, the Hall Calls report must first be updated through Update Reports or **Auto-Update** from the **Options** menu.

**NOTE:** You do not have to be connected in order to view this report.

---

**Date**

The Date window is used to display the data for the period you wish to view. The period will not be saved session to session. Once the report window is closed, these changes will be lost.

In order to change the period, select the start date by clicking on the down arrow and highlighting the date you wish the report to begin (A). The same holds true for the end date (B).

To save your changes and close this window, click the **Close** button (C). To close this window without saving your changes, click the **Cancel** button (D).
Preferences

The Preferences window lets you select the interval and threshold. These selections will be saved from session to session.

In this window, you can change the interval that is used. The Interval can be any number that you wish to be the column value (A). The Threshold is the last interval displayed and has a maximum value of 120 seconds (2 minutes) (B). In the above example, all hall call wait times equal to and greater than 61 seconds will be the last column displayed on the report.

To save your changes and close the Preferences window, click on the Close button (C). To close this window without saving your changes, click on the Cancel button (D).

Cars In Service

For further information, refer to the Common Report Windows section at the beginning of this chapter.

Sample Analysis

The sample report at the beginning of this section shows that there were a total of 1303 hall calls, both directions, made on April 27, 1995 between the hours of 00:00 and 23:59.

Most calls, in either direction, had a waiting period of 0 - 10 seconds. Interesting to note is that there were a total of 166 hall calls, both directions, where the wait time was greater than 61 seconds. 123 of the 166 hall calls were for the down direction.
The Hall Call Log is a tool that measures hall call traffic for any given period of time for a specific job. If you wish to view a different job, click on the down arrow in the Selected Job DropDownListBox and highlight a job (A).

This tool can be customized to fit your needs. You can specify the time frame for which the information will be displayed (C). This information is displayed at the bottom of the window (I). You can also specify certain cars or floors to be displayed (D). This allows you to focus your monitoring on specific situations. Up to eight levels of sorting can be done in ascending or descending order (E). The sort is also displayed at the bottom of the window (I). Also provided is a summary report showing totals by car and floor (G). To view the percentage of cars in service, click on the Cars In Service button (F). For more information about cars in service, refer to the Common Report Windows section at the beginning of this chapter.
Upon opening this window, the first row will be highlighted. Use the scroll bar to the right of the report to view additional rows not displayed. The scroll bar will not appear if all the data fits on one page.

To print this window, click on the **Print** button (H).

To close this window, click on the **Close** button (B).

**NOTE:** In order to get the data for this report, the Hall Calls report must first be updated through Update Reports or **Auto-Update** from the **Options** menu at connection time.

**NOTE:** You do not have to be connected in order to view this report.

### Date and Time

The Date and Time window is used to display the data for the period you wish to view. This information will not be saved session to session. Once the report window is closed, these changes will be lost.

In order to change the period, select the start date by clicking on the down arrow and highlighting the date you wish the report to begin (A).
Select the start time by clicking on the up and down arrows to set the time (B). The same holds true for the end date and time (C and D).

To save your changes and close this window, click the Close button (E). To close this window without saving your changes, click the Cancel button (F).

**Select**

The Select window is used to filter and view specific data in the report. These selections will be saved from session to session.

To select the car(s) and floor(s) to be included on the report, highlight the selection (A and B). At least one car and one floor must be highlighted. To select or unselect all cars and floors at once, click on the Select All and Unselect All buttons, respectively (C, D, E and F).

You may choose the direction (G), door (H), and hallway (I).

To show hall calls with a specific wait time, click on the down arrow of the Wait Time DropDownListBox and highlight the sign to be used.
Use the SpinControl to increase or decrease the number of seconds. If you wish to view all hall calls, select a Wait Time of > 0 (L).

To save your changes and close this window, click on the Close button (J). To close this window without saving your changes, click on the Cancel button (K).

Preferences

The Preferences window allows you to define the sort and indicators. These selections will be saved from session to session.

To change the hall call report sort criteria, click on the Sort button (A). For further information regarding sort, refer to the Common Report Windows section at the beginning of this chapter.

When you would like to flag (indicate on the report) hall calls that meet specific criteria with regards to the Wait Time, begin by selecting the indicator that you wish to use (B). The indicator is what is displayed to the right of the report. The indicator can be an Arrow, Hand, Green Flag, or Red Flag. Next you will need to select the condition on which you would like the indicator to be displayed. This is done by selecting the sign, which can be any of the following: <, >, <=, >=, or =, and then by selecting the seconds of wait time (C).

To save your changes and close this window, click the Close button (D). To close this window without saving your changes, click the Cancel button (E).
Summary

The Summary window displays summarized information about the displayed report. The same filter (as selected in the Select window) that applies to the report applies to the Summary window.

For each car that the job has, the total number of hall calls registered is displayed. A grand total will be displayed at the bottom (A).

The totals are displayed for each floor from which a hall call was registered (B).

Use the scroll bar to the right of the report to view additional cars and floors that are not displayed. The scroll bar will not appear if all the data fits on one page.

The Total Number of Calls reflects the total number of cars, regardless of what car or floor is used (C).

The Median Wait Time is the middle hall call wait time, meaning half of the hall call wait times are greater than the median and half of the hall call wait times are less than the median (D).
The **Minimum Wait Time** reflects the shortest time someone had to wait for an elevator in the hallway (**E**).

The **Maximum Wait Time** reflects the longest time someone had to wait for an elevator in the hallway (**F**).

To close the window, click the **Close** button (**G**).

To print the report, click the **Print** button (**H**).

---

**Sample Analysis**

The sample report at the beginning of this section shows all the hall calls that were made between August 29, 1995 00:00:00 and August 29, 1995 23:59:00. All the hall calls were from the Main Hallway using the Front Door in the Down direction.

The hall calls are sorted by floor in descending order.

All wait times greater than twenty seconds are flagged with an Arrow indicator. This allows you to scan the report more easily for specific conditions. Only records with a wait time greater than (>) twenty seconds are indicated by an arrow on the right-hand side. The wait time may not be a direct route from source floor to destination floor. The wait time includes many factors, such as stops between the source floor and destination floor, dispatching parameters, etc.

Let’s look at a specific hall call. The highlighted line on the report shows a hall call that was made on August 29, 1995 at 12:37:51 on the tenth floor. Six seconds later Car B answered that call.

If a car or floor appears to have a disproportionate number of hall calls, it is possible that there is something wrong. This may or may not be the case, but it is brought to your attention. View the summary report to quickly see totals for the number of hall calls per car and floor, the total number of calls, the median wait time, the minimum wait time, and maximum wait time.
The Traffic Analysis report displays the traffic overview for a specific job. If you wish to view a different job, click on the down arrow in the Selected Job DropDownListBox and highlight a job (A).

The report consists of the number of hall calls answered within specified intervals for each time slot and direction (B). It also includes the total number of hall calls, the longest call waiting time and the average waiting time for that time slot (C).

The report can be customized to fit your needs. You can specify the date, time period and the time interval (In Minutes) for which the information will be displayed. This information is displayed at the bottom of the window (D). Click on the Date and Time button to change the date, the time period and the time interval (E).
To view the report for all Up calls click on the **Up** radio button (F). To view the report for all down calls click on the **Down** radio button (G). To view the reports for both Up as well as Down calls simultaneously click on the **Up and Down** radio button (H). To view a combined report of Up and Down calls click on the **Combined** radio button (I).

To view the percentage of cars in service click on the **Cars In Service** button (K). For more information about cars in service, refer to the **Common Reports Window** section at the beginning of this chapter.

Click on the **Print** button to send a copy of the report currently in view to the printer (L).

Click on the **Close** button to close this window (J).

NOTE: In order to view any data for this report the Hall Calls report must first be updated through **Update Reports** or **Auto-Update** from the **Options** menu

NOTE: You do not have to be connected in order to view this report.

The Date and Time window is used to display the data for the period and time interval that you wish to view. This information will not be saved from session to session.

In order to change the date, select the date by clicking on the down arrow of the **Date DropDownListBox** and highlighting the date for which you wish to view the report (A). Select the start time by clicking on either the up or down arrows in the **Start edit mask** to increase or decrease the start time (B). The same holds true for the end time (C). Select the interval by clicking on the down arrow of the **Interval in Minutes DropDownListBox** (D).

The interval options are displayed in steps of five minute increments ranging from 5 to 60 minutes. The minimum value available for display
depends on the difference between the start time and end time as shown in the table below.

To save your changes and close this window, click the **Close** button (E).

To close this window without saving your changes, click the **Cancel** button (F).

<table>
<thead>
<tr>
<th>Time Difference</th>
<th>Minimum Interval</th>
<th>Maximum Interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>less Than or Equal to 4 hours</td>
<td>5 Minutes</td>
<td>60 Minutes</td>
</tr>
<tr>
<td>Greater Than 4 hours and less than 8 hours</td>
<td>10 Minutes</td>
<td>60 Minutes</td>
</tr>
<tr>
<td>Greater Than or Equal to 8 hours and less than 16 hours</td>
<td>15 Minutes</td>
<td>60 Minutes</td>
</tr>
<tr>
<td>Greater Than or Equal to 16 hours and less than 24 hours</td>
<td>30 Minutes</td>
<td>60 Minutes</td>
</tr>
</tbody>
</table>
The Car Call Log is a tool that measures car call traffic for any given period of time for a specific job. If you wish to view a different job, click on the down arrow in the Selected Job DropDownListBox and highlight a job (A).

This tool can be customized to fit your needs. You can specify the time frame for which the information will be displayed (D). This information is displayed at the bottom of the window (J). You can also specify certain cars or floors to be displayed (E). This allows you to focus your monitoring on specific situations. Up to eight levels of sorting can be done in ascending or descending order (F). The sort is displayed at the bottom of the window (J). Also provided is a summary report showing totals by car and floor (H). To view the percentage of cars in service, click on the Cars In Service button (G). For more information...
about cars in service, refer to the **Common Report Windows** section at the beginning of this chapter.

Upon opening this window, the first row will be highlighted. Use the scroll bar to the right of the report to view additional rows not displayed. The scroll bar will not appear if all the data fits on one page.

To print this window, click on the **Print** button (I). To close this window, click on the **Close** button (B).

---

### Date and Time

The Date and Time window is used to display the data for the period you wish to view. This information will not be saved session to session. Once the report window is closed, these changes will be lost.

In order to change the period, select the start date by clicking on the down arrow and highlighting the date on which you wish the report to
begin (A). Select the start time by clicking on the up and down arrows (B). The same holds true for the end date and time (C and D).

To save your changes and close this window, click the Close button (E). To close this window without saving your changes, click the Cancel button (F).

Select

The Select window is used to filter and view specific data in the report. These selections will be saved from session to session.

To select the source floor(s), destination floor(s) and car(s) to be included on the report, highlight the selection (A, D, and G). At least one source floor, destination floor, and car must be highlighted. To select or unselect all items at one time, click on the Select All or Unselect All buttons, respectively (B, C, E, F, H, and I).

You may choose Front and/or Rear doors (J).

To show car calls with a specific travel time, click on the down arrow of the Travel Time DropDownListBox and highlight the sign to be used. Use the SpinControl to increase or decrease the number of seconds. For example, to see all the car calls that have traveled
more than 50 seconds, select a **Travel Time** of > 50. If you wish to view all car calls, select a **Travel Time** of > 0 \((K)\).

To save your changes and close this window, click on the **Close** button \((L)\). To close this window without saving your changes, click on the **Cancel** button \((M)\).

**Preferences**

The Preferences window allows you to define the sort and indicators. These selections will be saved from session to session.

To change the car calls’ reports sort criteria, click on the **Sort** button \((A)\). For further information regarding the sort, refer to the **Common Report Windows** section at the beginning of this chapter.

When you would like to flag (indicate on the report) car calls that meet specific criteria with regards to the travel time, begin by selecting the indicator that you wish to use \((B)\). The indicator will be displayed to the right of the report. The indicator can be an Arrow, Hand, Green Flag, or Red Flag. Next, select the condition on which you would like the indicator to be displayed. This is done by selecting the sign, which can be any of the following: <, >, <=, >=, or = and then by selecting the seconds of travel time \((C)\).

To save your changes and close this window, click the **Close** button \((D)\). To close this window without saving your changes, click the **Cancel** button \((E)\).
For further information, refer to the Common Report Windows section at the beginning of this chapter.

**Summary**

The Summary window displays summarized information about the displayed report. The same filter (as selected in the Select window) that applies to the report, applies to the Summary window.

Each car is displayed, along with the number of car calls that were assigned to the call. A grand total is displayed at the bottom. (A)

For each car that the job has, the total number of car calls registered is displayed. A grand total will be displayed (in red) at the bottom (A).

For each source floor that a car call was initiated from, the number of entries is displayed (B).

For each destination floor that a car traveled to, the number of exits is displayed (C).

Use the scroll bar to the right of the report to view additional cars, source floors and destination floors that are not displayed. The scroll bar will not appear if all the data fits on one page.

Each source floor is displayed, along with the number of times it was used to enter the elevator. (B)

Each destination floor is displayed, along with the number of times it was used to exit from the elevator. (C)
To close the window, click the **Close** button (D).

To print the report, click the **Print** button (E).

---

**Sample Analysis**

The sample report shown at the beginning of this section shows all the car calls that were made between June 30, 1995 00:00:00 and July 17, 1995 23:59:00. All the car calls are for Car 1 with a variety of source floors and destination floors using only the front door.

The car calls are sorted first by date and time, and secondly by destination floor, both in ascending order.

All travel times greater than thirty seconds are flagged with an Arrow indicator. This allows you to scan the report more easily for specific conditions. Only records with a travel time greater than (>30) thirty seconds are indicated by an arrow on the right-hand side. The travel time may not be a direct route from source floor to destination floor. The travel time includes many factors, such as stops between the source floor and destination floor, dispatching parameters, etc.

Let’s look at a specific car call. On the first line of the report, a car call was generated on June 30, 1995 at 10:52:20 from Car 1. Car 1 is located in the Lobby (L) and is assigned to the ground floor (G). The call was registered on the front door of Car 1. Since some cars may have front and/or rear doors, this information is also included. It took a total of seven seconds for Car 1 to travel from the source floor, the Lobby, to the destination floor, the ground floor.

If a car, source floor or destination floor, appears to have a disproportionate number of car calls, it is possible that there is something wrong. This may or may not be the case, but it is brought to your attention. View the summary report to quickly see totals for the number of calls per car, the number of entries at each source floor, and the number of exits from each destination floor.
System Performance

The System Performance report is a graphical representation of up to 24 hours of up and down hourly hall call averages or the number of up and down hall calls for a specific job. If you wish to view a different job, click on the down arrow in the Selected Job DropDownListBox and highlight a job (A). This tool can be customized to fit your needs. You can specify the time frame for which the information will be displayed (C). This information is displayed at the bottom of the window (J). To select the type of graph you wish to view for the system performance, click on the Preferences button (D). Also provided is a summary report showing totals by car and floor (E). If you wish to view a legend, click on the Include CheckBox in the Legend GroupBox (F). The legend may appear in four different places on the report: left, right, top, and bottom (G).
The two versions of the System Performance report can be displayed separately or together. To display a report, click on the CheckBox(es) corresponding to the report that you wish to view (H).

To print this window, click on the Print button (I).

To close this window, click on the Close button (B).

**NOTE:** In order to view any data for this report, the System Performance report must first be updated through Update Reports or Auto-Update from the Options menu.

**NOTE:** You do not have to be connected in order to view this report.

**Date**

The Date window is used to display the data for the period that you wish to view. The period will not be saved session to session. Once the report window is closed, these changes will be lost.

In order to change the period, select the date by clicking on the down arrow and highlighting the desired date. All hours of the day are included in this report. (A)
To save your changes and close this window, click on the Close button (B). To close this window without saving your changes, click on the Cancel button (C).

**Preferences**

The Preferences window lets you select the graph type with which you wish to view the system performance. These selections will be saved from session to session.

![Preferences window diagram]

In order to change the graph type, select the report name or select Both (A). Click on the Change button to display another window, then click on the graph you want (B). For further details refer to the Common Report Windows - Graph Type section at the beginning of this chapter (C).

**NOTE:** Depending on the graph selected, the report may not make sense. Recommended graph types for this report are: Line (2D), Scatter (2D), Solid Bar, and Solid Column.

To save your changes and close this window, click on the Close button (D). To close this window without saving your changes, click on the Cancel button (E).
The Summary window displays summarized information about the displayed report. The same filter (as selected in the Select window) that applies to the report applies to the Summary window. The summary will display the average of the report(s) displayed in the System Performance Window.

The type of graph on this window matches the type of graph shown in the detailed version of this report. This graph depicts the average of the up and down hall calls average wait times and the average number of up and down hall calls.

Close this window by clicking on the Close button (A).

Print the data on this window by clicking on the Print button (B).

The sample report at the beginning of this section shows a heavy volume of traffic between the hours of 6 AM through 12 AM. This tapers off slightly and becomes steady between the hours of 1 PM through 11 PM. Between the hours of 12 PM and 6 AM, traffic is greatly reduced.

Also note the direction of the traffic. Most traffic is in the down direction. Only during the late night and early morning hours is the majority of the traffic in the up direction. Up and down calls are represented in green
and red, respectively. Refer to the legend displayed at the bottom of the report.

The average wait time reflects the number of hall calls that are being registered.

### Hall Call Distribution

The Hall Call Distribution report displays the hour’s hall calls overview for a specific job. If you wish to view a different job, click on the down arrow in the Selected Job DropDownListBox and highlight a job (A). This report consists of the number of hall calls answered within specified intervals for each landing and direction. It also includes the total number and percentage of hall calls for that hour.

This tool can be customized to fit your needs. You can specify the time frame for which the information will be displayed (C). This information is displayed at the bottom of the window (H). Up to four different
intervals can be defined (D). In order to display the same floors for both up and down directions, when scrolling, click on the Yes CheckBox in the Synchronize GroupBox (E).

The Up, Down, or both reports may be viewed at the same time or individually (F).

NOTE: You do not have to be connected in order to view this report.

NOTE: In order to view any data for this report, the Hall Call Distribution report must first be updated through Update Reports or Auto-Update from the Options menu.

Click on the Print button to send a copy of this report to your printer (G).

Click on the Close button to close this window (B).

Date and Time

The Date and Time window is used to display the data for the period that you wish to view. The period will not be saved session to session. Once the report window is closed, these changes will be lost.

In order to change the period, select the start date by clicking on the down arrow and highlighting the date on which you wish the report to begin (A). Select the start hour by clicking on either the up or down...
arrows to increase or decrease the time (B). The same holds true for the end date and time (C and D).

To save your changes and close this window, click the **Close** button (E). To close this window without saving your changes, click the **Cancel** button (F).

**Preferences**

The Preferences window lets you select the interval. This selection will be saved from session to session.

In this window, you can change the interval that is used. The interval can be one of four values: 15, 30, 45, and 90.

![Preferences window](image)

**Cars In Service**

For further information, refer to the **Common Report Windows** section at the beginning of this chapter.

**Sample Analysis**

The sample report at the beginning of this section shows that there were a total of 1303 hall calls made on April 27, 1995 between the hours of 00:00 and 23:59.

Most calls, in either direction, had a waiting period of 0 - 15 seconds. Interesting to note is that there were 166 hall calls, both directions, where the wait time was greater than 91 seconds.
**Event Calendar**

The Event Calendar report displays a listing of all events that have occurred within a specified period of time for a specific job. If you wish to view a different job, click on the down arrow in the Selected Job DropDownListBox and highlight a job (A).

This tool can be customized to fit your needs. You can specify the time frame for which the information will be displayed (D). This information is displayed at the bottom of the window (K). You can also specify certain cars or floors to be displayed (E). This allows you to focus your monitoring on specific situations. Up to eight levels of sorting can be done in ascending or descending order (F). The sort is displayed at the bottom of the window (K). Also provided is a summary report showing totals by car and floor (H). Click on the Search button to search for an event (I). To view the percentage of cars in service, click on the Cars button.

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Event Description</th>
<th>Status</th>
<th>Car</th>
<th>Floor</th>
</tr>
</thead>
<tbody>
<tr>
<td>04/28/95</td>
<td>13:41</td>
<td>Time Out of Service</td>
<td>Deactivated</td>
<td>B</td>
<td>2</td>
</tr>
<tr>
<td>04/28/95</td>
<td>13:41</td>
<td>Photo Eye Failure</td>
<td>Deactivated</td>
<td>B</td>
<td>3</td>
</tr>
<tr>
<td>04/28/95</td>
<td>13:40</td>
<td>Time Out of Service</td>
<td>Deactivated</td>
<td>B</td>
<td>9</td>
</tr>
<tr>
<td>04/28/95</td>
<td>12:11</td>
<td>Time Out of Service</td>
<td>Deactivated</td>
<td>B</td>
<td>9</td>
</tr>
<tr>
<td>04/28/95</td>
<td>14:50</td>
<td>Lift Floor Demand</td>
<td>Activated</td>
<td>A</td>
<td>8</td>
</tr>
<tr>
<td>04/28/95</td>
<td>14:50</td>
<td>Inspection</td>
<td>Deactivated</td>
<td>A</td>
<td>1</td>
</tr>
<tr>
<td>04/28/95</td>
<td>14:50</td>
<td>Platform Floor Demand</td>
<td>Activated</td>
<td>A</td>
<td>1</td>
</tr>
<tr>
<td>04/28/95</td>
<td>13:17</td>
<td>Independent Service</td>
<td>Activated</td>
<td>A</td>
<td>1</td>
</tr>
<tr>
<td>04/28/95</td>
<td>13:17</td>
<td>Independent Service</td>
<td>Activated</td>
<td>A</td>
<td>1</td>
</tr>
<tr>
<td>04/28/95</td>
<td>13:16</td>
<td>Independent Service</td>
<td>Activated</td>
<td>A</td>
<td>1</td>
</tr>
<tr>
<td>04/28/95</td>
<td>13:12</td>
<td>Time Out of Service</td>
<td>Deactivated</td>
<td>B</td>
<td>7</td>
</tr>
<tr>
<td>04/28/95</td>
<td>13:11</td>
<td>Time Out of Service</td>
<td>Activated</td>
<td>B</td>
<td>8</td>
</tr>
</tbody>
</table>
In Service button (G). For more information, refer to the Common Report Windows section at the beginning of this chapter.

Upon opening this window, the first row will be highlighted. Use the scroll bar to the right of the report to view additional rows not displayed. The scroll bar will not appear if all the data fits on one page.

To print this window, click on the Print button (J).

To close this window, click on the Close button (B).

NOTE: In order to view any data for this report, the Event Calendar report must first be updated through Update Reports or Auto-Update from the Options menu.

NOTE: You do not have to be connected in order to view this report.

Date and Time

The Date and Time window is used to display the data for the period that you wish to view. The period will not be saved session to session. Once the report window is closed, these changes will be lost.

In order to change the period, select the start date by clicking on the down arrow and clicking on the date that you wish the report to start (A). Select the start time by clicking on the up and down arrows to (B). The same holds true for the end date and time (C and D).
To save your changes and close this window, click on the **Close** button (E). To close this window without saving your changes, click on the **Cancel** button (F).

---

**Select**

The Select window is used to filter and view specific data in the report. These selections will be saved from session to session.

To select the car(s), floor(s), and event(s) to be included on the report, highlight the selection (A, D, and G). At least one car, floor, and event must be highlighted. To select or unselect all items at one time, click on the **Select All** and **Unselect All** buttons, respectively (B, C, E, F, H, and I).

You may choose the state of the event, either Activated, Deactivated, or Both (J).

To save your changes and close this window, click on the **Close** button (K). To close this window without saving your changes, click on the **Cancel** button (L).
The Preferences window lets you select the sort and indicators. These selections will be saved from session to session.

To change the event calendar reports sort criteria, click on the Sort button (A). For further information regarding sort, refer to the Common Report Windows section at the beginning of this chapter.

When you would like to flag (indicate on the report) specific events, begin by selecting the indicator that you wish to use (B). The indicator is what is displayed to the right of the report. The indicator can be an Arrow, Hand, Green Flag, or Red Flag. This will provide a visual aid that will indicate when a specific event occurs.

Next you will need to select the events that you would like flagged. This is done by highlighting those events (C). To select or unselect all events at one time, click on the Select All and Unselect All buttons, respectively (D and E).

To save your changes and close this window, click on the Close button (F). To close this window without saving your changes, click on the Cancel button (G).
Cars In Service

For further information, refer to the Common Report Windows section at the beginning of this chapter.

Summary

The Summary window displays summarized information about the displayed report. The same filter (as selected in the Select window) that applies to the report, applies to the Summary window.

Each event is displayed along with the number of times that it occurred. \((A)\)

Each car is displayed along with the number of events that it had. \((B)\)

The total number of system events are displayed here. \((D)\)

Each floor is displayed along with the number of events that it had. \((C)\)

Each event displayed in the Event Calendar report will be displayed in this window, along with the number of times the event occurred \((A)\). This window also displays the number of events per car and the number of events per floor \((B)\) and \((C)\). For group systems, the number of events generated by the group will be displayed \((D)\).

Search

For further information, refer to the Common Report Windows section at the beginning of this chapter.
Sample Analysis

The sample report at the beginning of this section shows different events that have occurred between April 25, 1995 00:00 and April 29, 1995 23:59. Six unique events have been recorded: 1) Time Out of Service, 2) Photo Eye Failure, 3) Lost DLK During Run, 4) Bottom Floor Demand, 5) Inspection, and 6) Independent Service.

Let's look at a specific event. On April 29, 1995 at 13:40:01 Photo Eye Failure was activated. On that same day at 13:41:00, Photo Eye Failure was deactivated (C). Since this report is sorted by Date and Time in descending order (K), you will need to look from the bottom up to see the sequence of events.

Maintenance Log

The Maintenance Log report window lists all the maintenance logs entered by the registered maintenance mechanics. For more information about maintenance mechanics, please refer to the Maintenance Mechanics section of the Getting Started chapter.

This report displays the maintenance log records as entered by the mechanic. Each record consists of the date and time the record was
logged, the mechanic’s ID, the mechanic’s first name, the mechanic’s last name, and the type of action taken (A). There are two action types, Logged In and Logged Out. The Logged In action indicates when the mechanic started the maintenance work. The Logged Out action indicates when the mechanic finished the work. To see a detailed description of the maintenance work performed by the mechanic, click on the Comments... button (C). This will display the Maintenance Log Comments window as shown below.

To delete a maintenance log record, select the desired record, then click on the Delete button (D). This will permanently remove the log record from the system.

To print the Maintenance Log report, click on the Print button (E). To close the report, click on the Close button (B).
## Car Status Messages

<table>
<thead>
<tr>
<th>Status Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Alarm - No Car Movement</strong></td>
<td>Alarm bell was pressed while the car was not moving.</td>
</tr>
<tr>
<td><strong>Alarm - No Door Zone</strong></td>
<td>Alarm bell was pressed while the car was outside the door zone.</td>
</tr>
<tr>
<td><strong>Anti-nuisance - LLW (Light Load Weigher)</strong></td>
<td>The computer shall cancel all previously registered car calls if a predetermined adjustable number of registered car calls is exceeded while the Light Load function is active.</td>
</tr>
<tr>
<td><strong>Attendant Service</strong></td>
<td>The car is in attendant service operation. While in attendant service, the car will operate as follows:</td>
</tr>
<tr>
<td></td>
<td>▶ When the car is stopped at a landing, the doors will open automatically and will remain open until closed (by applying constant pressure on the door close button, car call button, or the up and down attendant buttons) by the attendant.</td>
</tr>
<tr>
<td></td>
<td>▶ The car will continue to receive hall call assignments. The car will answer the hall calls unless overridden by the attendant.</td>
</tr>
<tr>
<td><strong>Automatic Operation</strong></td>
<td>The car is running in automatic operation.</td>
</tr>
<tr>
<td><strong>Bottom Floor Demand</strong></td>
<td>The car has lost its landing position and is heading to the bottom floor to initialize its position. For DF cars, the car will go to the next floor to initialize its position. Once the landing position is initialized, the car will return to normal operation.</td>
</tr>
<tr>
<td><strong>Brake Lifted</strong></td>
<td>The car brake was lifted.</td>
</tr>
<tr>
<td><strong>Car Not Responding</strong></td>
<td>The car is not responding to hall calls or car calls.</td>
</tr>
<tr>
<td><strong>Car On Emergency Power</strong></td>
<td>When an emergency power situation is detected, cars shall be returned to the main lobby one by one, and remain there with doors open. While each car is being returned, all other cars shall be shut down to prevent the emergency power generators from overloading. Once all cars have returned to the lobby, one or more cars may be selected to run under emergency power, depending upon the capability of the emergency power generator. In any case, the group supervisory computer shall not allow more cars to run than can be safely handled by the emergency power generator. The actual number of cars allowed to run under emergency power is a predetermined adjustable value.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>Earthquake Operation</strong></td>
<td>Car is running in earthquake operation according to applicable codes.</td>
</tr>
<tr>
<td><strong>Emergency Power, Car Off</strong></td>
<td>When an emergency power situation is detected, cars shall be returned to the main lobby one by one, and remain there with doors open. While each car is being returned, all other cars shall be shut down to prevent the emergency power generators from overloading. Once all cars have returned to the lobby, one or more cars may be selected to run under emergency power, depending upon the capability of the emergency power generator. The group dispatcher has selected to shutdown this particular car.</td>
</tr>
<tr>
<td><strong>Fire Phase 1 (Main)</strong></td>
<td>The car is operating in Fire Phase I emergency recall. The car is at or is heading to the main floor. This operation is provided according to applicable local codes.</td>
</tr>
<tr>
<td><strong>Fire Phase 1 (Alternate)</strong></td>
<td>The car is operating in Fire Phase I emergency recall. However, the car is at or is heading to the alternate floor. This operation is provided according to applicable local codes.</td>
</tr>
<tr>
<td><strong>Fire Phase 2</strong></td>
<td>The car is running a fireman’s operation. The car will only respond to car calls from the car operating panel.</td>
</tr>
<tr>
<td><strong>Hall Call ByPass - HLW (High Load Weigher)</strong></td>
<td>Cars shall bypass hall calls if loaded to a predetermined adjustable load level as set by the load weigher.</td>
</tr>
<tr>
<td><strong>Hospital Emergency</strong></td>
<td>The car is running a hospital emergency service. All the car calls are canceled and any hall calls that have previously been assigned to this car will be transferred to other cars (if any).</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>In Car Stop Switch</strong></td>
<td>The car’s stop switch was activated.</td>
</tr>
<tr>
<td><strong>Independent Service</strong></td>
<td>The car is operating in Independent service. All cars are provided with an Independent service key switch in the car operating panel. The actuation of the key switch will cancel any existing car calls, and hold the doors open at the landing. The car will then respond only to car calls. Car and hoistway doors will only close with constant pressure on a car call push-button or the door close button.</td>
</tr>
<tr>
<td><strong>In Service</strong></td>
<td>The car is running in normal operation.</td>
</tr>
<tr>
<td><strong>Inspection Access</strong></td>
<td>The car is on inspection operation.</td>
</tr>
<tr>
<td><strong>Leveling</strong></td>
<td>The car is leveling at the landing. Each car is equipped with a two-way leveling to automatically bring the car level at any landing, within the required range of leveling accuracy, with any load up to full load.</td>
</tr>
<tr>
<td><strong>LSA Movement Failure</strong></td>
<td>The car has failed the Lift System Analysis (L.S.A.) check. If the car is L.S.A. enabled and it has been parked for a predetermined time period, the car will run a L.S.A. check to make sure that it is operational. The test constitutes running the car one floor, cycling the doors and returning the car to its parking floor.</td>
</tr>
<tr>
<td><strong>MG Shut Down</strong></td>
<td>If the car has no call demand before the MG Shutdown time, then the MG will be set to shutdown.</td>
</tr>
<tr>
<td><strong>Motor Limit Timer Elapsed</strong></td>
<td>The car has timed out while detecting if the motor is running.</td>
</tr>
<tr>
<td><strong>Nudging</strong></td>
<td>The doors are nudging; there might be an obstacle in the doors path. The doors will continue to close at reduced speed.</td>
</tr>
<tr>
<td><strong>Off Line</strong></td>
<td>The car is either not communicating with or not connected to the group dispatcher.</td>
</tr>
<tr>
<td><strong>Out of Service</strong></td>
<td>Automatically removes any car from group operation should the car be delayed from responding to its demand for a predetermined field adjustable period of time. The system shall automatically restore any car back to group operation when the reason for the delay has been corrected. This is programmable from each of the car computers or from the group.</td>
</tr>
<tr>
<td><strong>Over Travel</strong></td>
<td>When the car reaches the destination floor, it tries to stop between the floor level indicators. The Over Travel message appears when the car has passed the level indicator in the direction of travel.</td>
</tr>
<tr>
<td><strong>Parked</strong></td>
<td>The car has no call demand and it is parked.</td>
</tr>
<tr>
<td><strong>Photo Eye Failure</strong></td>
<td>The Photo Eye sensor is stuck or not responding.</td>
</tr>
<tr>
<td><strong>Re-leveling</strong></td>
<td>When the car reaches the destination floor, it tries to stop between the floor level indicators. The car has detected that it has passed the floor level indicators and it is repositioning itself.</td>
</tr>
<tr>
<td><strong>Roll Back</strong></td>
<td>For Distance Feedback cars only. The car is trying to stop at the destination floor, but it has moved a predetermined distance in the opposite direction of travel due to control loop compensation for velocity error.</td>
</tr>
<tr>
<td><strong>Running Down</strong></td>
<td>The car is moving in the Down direction.</td>
</tr>
<tr>
<td><strong>Running Up</strong></td>
<td>The car is moving in the Up direction.</td>
</tr>
<tr>
<td><strong>Safety Edge Failure</strong></td>
<td>The car’s safety edge is stuck on.</td>
</tr>
<tr>
<td><strong>Safety String Open</strong></td>
<td>A safety contact is open in the safety string.</td>
</tr>
<tr>
<td><strong>Speed Out of Limits</strong></td>
<td>The car is outside the speed limit computed by the controller. For this event, the controller monitors contract speed, inspection speed, and leveling speed.</td>
</tr>
<tr>
<td><strong>Swing Car Operation</strong></td>
<td>The car is in a swing operation.</td>
</tr>
<tr>
<td><strong>Timed Out Of Service</strong></td>
<td>After the car establishes a direction, if it does not step within the TOS time, the car is placed in ‘Timed Out of Service’ status, and all the assigned hall calls will be transferred to another car. TOS also triggers the Nudging function.</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Top Floor Demand</strong></td>
<td>The car has lost its landing position and is heading to the top floor to initialize its position. For DF cars, the car will go to the next floor to initialize its position. Once the landing position is initialized, the car will return to normal operation.</td>
</tr>
</tbody>
</table>
## Appendix B
### User Tasks (Privileges)

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Settings (view)</td>
<td>Allows the user to change his/her password, view the list of jobs that (s)he can connect to, and view the list of tasks that (s)he has access to. To access the account settings window, click on the <strong>File</strong> menu, select <strong>Setup</strong>, then select <strong>Account Settings</strong>.</td>
</tr>
<tr>
<td>Add System</td>
<td>Allows the user to add an elevator system to CMS for Windows for monitoring. To add a system to CMS, click on the <strong>File</strong> menu then select <strong>Add System</strong>.</td>
</tr>
<tr>
<td>Auto Hoistway Display Setup</td>
<td>Allows the user to Modify the Hoistway parameters. This window contains all the settings that control the automatic display of the Hoistway. If the user is assigned this task, (s)he can modify the Auto Hoistway Display setup window, click on the <strong>File</strong> name, select <strong>Setup</strong>, then select <strong>Auto Hoistway Display</strong>.</td>
</tr>
<tr>
<td>Auto-Update</td>
<td>Allows the user to run the Auto-Update process, as set in the Auto Update Setup window, at any time. To run the Auto-Update process, click on the <strong>Options</strong> menu then select <strong>Auto Update</strong>.</td>
</tr>
<tr>
<td>Auto Update Setup (modify)</td>
<td>Allows the user to modify the Auto Update Setup window. This window contains all the settings required to run the Auto Update process. If the user is assigned this task, (s)he can view or change the Auto Update settings. To access the Auto Update Setup window, click on the <strong>File</strong> menu, select <strong>Setup</strong>, then select <strong>Auto Update Setup</strong>.</td>
</tr>
<tr>
<td>Auto Update Setup (view)</td>
<td>Allows the user to view the Auto Update Setup window. This window contains all the settings required to run the Auto Update process. If the user is assigned this task, (s)he can view the Auto Update settings, but may not change them. To access the Auto Update Setup window, click on the <strong>File</strong> menu, select <strong>Setup</strong>, then select <strong>Auto Update Setup</strong>.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Car Call Log</td>
<td>Allows the user to view the Car Call Log report. To view the Car Call Log report, click on the <strong>Reports</strong> menu then select <strong>Car Call Log</strong>.</td>
</tr>
<tr>
<td>Car Flags</td>
<td>Allows the user to view the Car Flags window. To access the Car Flags window, click on the <strong>Controller</strong> menu then select <strong>Car Flags</strong>.</td>
</tr>
<tr>
<td>Car Operating Parameters (modify)</td>
<td>Allows the user to modify the Car Operating Parameters window. This window contains the car door timers. If the user is assigned this task, (s)he can view or change the car operating parameters. To access the Car Operating Parameters window, click on the <strong>Controller</strong> menu, then select <strong>Car Operating Parameters</strong>.</td>
</tr>
<tr>
<td>Car Operating Parameters (view)</td>
<td>Allows the user to view the Car Operating Parameters window. This window contains the car door timers. If the user is assigned this task, (s)he can view the car operating parameters, but may not change them. To access the Car Operating Parameters window, click on the <strong>Controller</strong> menu, then select <strong>Car Operating Parameters</strong>.</td>
</tr>
<tr>
<td>Car Status</td>
<td>Allows the user to view the Car Status window. This window contains messages describing the current status of the car. To access the Car Status window, click on the <strong>Controller</strong> menu then select <strong>Car Status</strong>.</td>
</tr>
<tr>
<td>COM Ports Setup (modify)</td>
<td>Allows the user to modify the COM Port Setup window. This window contains all the settings required to establish a connection through the computer’s serial ports. If the user is assigned this task, (s)he can view or change the COM Port settings. To access the COM Port Setup window, click on the <strong>File</strong> menu, select <strong>Setup</strong>, then select <strong>COM Port Setup</strong>.</td>
</tr>
<tr>
<td>COM Ports Setup (view)</td>
<td>Allows the user to view the COM Port Setup window. This window contains all the settings required to establish a connection through the computer’s serial ports. If the user is assigned this task, (s)he can view the COM Port settings, but may not change them. To access the COM Port Setup window, click on the <strong>File</strong> menu, select <strong>Setup</strong>, then select <strong>COM Port Setup</strong>.</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Connect to Controller</td>
<td>Grants the user access to connect to the elevator systems. If the user is assigned this task (s)he will be able to connect to all the jobs that are assigned to him/her. Please refer to the <strong>Account Settings</strong> in the <strong>Getting Started</strong> section. To connect to a controller, click on the <strong>Controller</strong> menu, then select <strong>Connect</strong>.</td>
</tr>
<tr>
<td>Controller CMS Parameters (modify)</td>
<td>Allows the user to modify the Controller CMS Parameters window. This window contains the CMS settings that are stored on the controller side and that are required for the controller to call out with emergencies. If the user is assigned this task, (s)he can view or change the CMS parameters. To access the Controller CMS Parameters window, click on the <strong>Controller</strong> menu then select <strong>Controller CMS Parameters</strong>.</td>
</tr>
<tr>
<td>Controller CMS Parameters (view)</td>
<td>Allows the user to view the Controller CMS Parameters window. This window contains the CMS settings that are stored on the controller side and that are required for the controller to call out with emergencies. If the user is assigned this task, (s)he can view the CMS parameters but, may not change them. To access the Controller CMS Parameters window, click on the <strong>Controller</strong> menu then select <strong>Controller CMS Parameters</strong>.</td>
</tr>
<tr>
<td>Controller Configuration</td>
<td>Allows the user to view the Controller Configuration window. This window contains elevator settings specified when the elevator was ordered. These settings can not be changed from CMS. To access the Controller Configuration window, click on the <strong>Controller</strong> menu then select <strong>Controller Configuration</strong>.</td>
</tr>
<tr>
<td>Create Maintenance Log</td>
<td>Allows the user to create a maintenance log for work performed on the elevator systems. The maintenance log includes the mechanic’s name, identification number, date and time the work is performed, and a description of the work. To create a maintenance log, click on the <strong>Options</strong> menu, then select <strong>Create Maintenance Log</strong>.</td>
</tr>
<tr>
<td>Dispatcher (modify)</td>
<td>Allows the user to modify the Dispatcher window. This window contains the elevator’s dispatching parameters, which affect the elevator response. If the user is assigned this task, (s)he can view or change the dispatching parameters. To access the Dispatcher Parameters window, click on the Controller menu, then select Dispatcher.</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dispatcher (view)</td>
<td>Allows the user to view the Dispatcher window. This window contains the elevator’s dispatching parameters, which affect the elevator response. If the user is assigned this task, (s)he can view the dispatching parameters, but may not change them. To access the Dispatcher Parameters window, click on the Controller menu, then select Dispatcher.</td>
</tr>
<tr>
<td>Emergency Report Setup (modify)</td>
<td>Allows the user to modify the Emergency Report Setup window. This window contains all the settings required to receive emergencies from the elevator systems. If the user is assigned this task, (s)he can view or change the emergency report settings. To access the Emergency Report Setup window, click on the File menu, select Setup, then select Emergency Report Setup.</td>
</tr>
<tr>
<td>Emergency Report Setup (view)</td>
<td>Allows the user to view the Emergency Report Setup window. This window contains all the settings required to receive emergencies from the elevator systems. If the user is assigned this task, (s)he can view the emergency report settings, but may not change them. To access the Emergency Report Setup window, click on the File menu, select Setup, then select Emergency Report Setup.</td>
</tr>
<tr>
<td>Emergency Trans. Errors</td>
<td>Allows the user to view the Emergency Transmission Errors report. To view the Emergency Transmission Errors report, click on the Reports menu, then select Emergency Transmission Errors.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Event Calendar</td>
<td>Allows the user to view the Event Calendar report. To view the Event Calendar report, click on the <strong>Reports</strong> menu, select <strong>Standard Reports</strong>, then select <strong>Event Calendar</strong>.</td>
</tr>
<tr>
<td>Group Status</td>
<td>Allows the user to view the Group Status window. This window contains messages describing the current status of the group supervisor. To access the Group Status window, click on the <strong>Controller</strong> menu, then select <strong>Group Status</strong>.</td>
</tr>
<tr>
<td>Hall Call Analysis</td>
<td>Allows the user to view the Hall Call Analysis report. To view the Hall Call Analysis report, click on the <strong>Reports</strong> menu, select <strong>Hall Calls</strong>, then select <strong>Hall Call Analysis</strong>.</td>
</tr>
<tr>
<td>Hall Call Distribution</td>
<td>Allows the user to view the Hall Call Distribution report. To view the Hall Call Distribution report, click on the <strong>Reports</strong> menu, select <strong>Standard Reports</strong>, then select <strong>Hall Call Distribution</strong>.</td>
</tr>
<tr>
<td>Hall Call Log</td>
<td>Allows the user to view the Hall Call Log report. To view the Hall Call Log report, click on the <strong>Reports</strong> menu, select <strong>Hall Calls</strong>, then select <strong>Hall Call Log</strong>.</td>
</tr>
<tr>
<td>Hoistway Display</td>
<td>Allows the user to view the Hoistway Display window. This window displays a graphical representation of the elevator hoistway and displays cars position and door status. If the user is assigned this task (s)he can view the cars positions, but cannot register hall calls or car calls. For the user to be able to register hall calls and car calls, (s)he must be assigned <strong>Register Hall Calls</strong> and <strong>Register Car Calls</strong> tasks. To access the Hoistway Display window, click in the <strong>Controller</strong> menu then select <strong>Hoistway Display</strong>.</td>
</tr>
<tr>
<td>Keyboard Control</td>
<td>Allows the user to modify the Keyboard Control (KCE) window. This window allows the user to control the operation of the elevator from a remote location. If the user is assigned this task, (s)he can view the elevator status and control the elevator remotely. To access the Keyboard Control window, click on the <strong>Controller</strong> menu, then select <strong>Keyboard Control (KCE)</strong>.</td>
</tr>
<tr>
<td><strong>Keyboard Control KCE - (view)</strong></td>
<td>Allows the user to view the Keyboard Control (KCE) window. This window allows the user to control the operation of the elevator from a remote location. If the user is assigned this task, (s)he can view the elevator status, but may not control the elevator. To access the Keyboard Control window, click on the <strong>Controller</strong> menu, then select <strong>Keyboard Control (KCE)</strong>.</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Maintenance Log Report (modify)</strong></td>
<td>Allows the user to modify the Maintenance Log report. The Maintenance Log report contains a listing of all the maintenance logs as entered by the mechanics. If the user is assigned this task, (s)he can view and delete the maintenance logs. To access the Maintenance Log report, click on the <strong>Reports</strong> menu, then select <strong>Maintenance Log Report</strong>.</td>
</tr>
<tr>
<td><strong>Maintenance Log Report (view)</strong></td>
<td>Allows the user to view the Maintenance Log report. The Maintenance Log report contains a listing of all the maintenance logs as entered by the mechanics. If the user is assigned this task, (s)he can view but may not delete the maintenance logs. To access the Maintenance Log report, click on the <strong>Reports</strong> menu, then select <strong>Maintenance Log Report</strong>.</td>
</tr>
<tr>
<td><strong>Maintenance Mechanics (modify)</strong></td>
<td>Allows the user to modify the Maintenance Mechanics list in CMS. If the user is assigned this task, (s)he can add, edit, and delete maintenance mechanics’ information from the system. Only mechanics who are registered in CMS can create maintenance logs. To access the Maintenance Mechanics window, click on the <strong>File</strong> menu, select <strong>Setup</strong>, then select <strong>Maintenance Mechanics Setup</strong>.</td>
</tr>
<tr>
<td><strong>Maintenance Mechanics (view)</strong></td>
<td>Allows the user to view the list of Maintenance Mechanics registered in CMS. If the user is assigned this task, (s)he can view the list of maintenance mechanics, but may not add, edit, or delete the mechanics’ information from the system. Only mechanics who are registered in CMS can create maintenance logs. To access the Maintenance Mechanics window, click on the <strong>File</strong> menu, select <strong>Setup</strong>, then select <strong>Maintenance Mechanics Setup</strong>.</td>
</tr>
<tr>
<td><strong>Modem Parameters (modify)</strong></td>
<td>Allows the user to modify the Modem Parameters window. This window allows the user access to the modem strings stored on the controller. If the user is assigned this task, (s)he can view or change the modem strings. To access the Modem Parameters window, click on the <strong>Controller</strong> menu, then select <strong>Modem Parameters</strong>.</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Modem Parameters (view)</strong></td>
<td>Allows the user to view the Modem Parameters window. This window allows the user to access the modem strings stored on the controller. If the user is assigned this task, (s)he can view modem strings, but may not change them. To access the Modem Parameters window, click on the <strong>Controller</strong> menu, then select <strong>Modem Parameters</strong>.</td>
</tr>
<tr>
<td><strong>Modify System</strong></td>
<td>Allows the user to change an existing elevator system's information. To modify a system, click on the <strong>File</strong> menu, then select <strong>Modify System</strong>.</td>
</tr>
<tr>
<td><strong>Open System</strong></td>
<td>Allows the user to open a window for an elevator system. Through this window, the user will be able to connect to the elevator system. To open a system window, click on the <strong>File</strong> menu, then select <strong>Open System</strong>.</td>
</tr>
<tr>
<td><strong>Pager Setup (modify)</strong></td>
<td>Allows the user to modify the Pager Setup window. This window contains all the information required by CMS to notify the designated pager of elevator faults. This window allows the user to activate/deactivate pagers, set pagers schedules, and set pagers jobs. If the user is assigned this task, (s)he can add new pagers and change their schedules. To access the Pager Setup window, click on the <strong>File</strong> menu, select <strong>Setup</strong>, then select <strong>Pager Setup</strong>.</td>
</tr>
<tr>
<td><strong>Pager Setup (view)</strong></td>
<td>Allows the user to view the Pager Setup window. This window contains all the information required by CMS to notify the designated pager of elevator faults. This window allows the user to activate/deactivate pagers, set pager schedules, and set pager jobs. If the user is assigned this task, (s)he can view the pager settings, but may not change them. To access the Pager Setup window, click on the <strong>File</strong> menu, select <strong>Setup</strong>, then select <strong>Pager Setup</strong>.</td>
</tr>
<tr>
<td><strong>Printer Setup</strong></td>
<td>Allows the user to access the Printer Setup window. This window allows the user to set up the printer for printing. To access the Printer Setup window, click on the <strong>File</strong> menu, then select <strong>Printer Setup.</strong></td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Programmable Events (modify)</strong></td>
<td>Allows the user to modify the Programmable Events window. This window allows the user to select the events monitored by CMS. Each event can be set in one of three ways: <strong>Log</strong> - The event will be stored in the event calendar, <strong>Log &amp; Trigger</strong> - The event will be sorted in the event calendar and triggered as an emergency, or <strong>Neither</strong>. If the user has access to this window, (s)he can select the events monitored by CMS and their types. To access the Programmable Events window, click on the <strong>Controller</strong> menu, then select <strong>Programmable Events.</strong></td>
</tr>
<tr>
<td><strong>Programmable Events (view)</strong></td>
<td>Allows the user to View the Programmable Events window. This window allows the user to view the events monitored by CMS. Each event can be set in one of three ways: <strong>Log</strong> - The event will be stored in the event calendar, <strong>Log &amp; Trigger</strong> - The event will be sorted in the event calendar and triggered as an emergency, or <strong>Neither</strong>. If the user has access to this window, (s)he can view the events monitored by CMS and their types, but may not change them. To access the Programmable Events window, click on the <strong>Controller</strong> menu, then select <strong>Programmable Events.</strong></td>
</tr>
<tr>
<td><strong>Real Time Clock (modify)</strong></td>
<td>Allows the user to modify the Real Time Clock window. This window allows the user access to the elevator’s real time clock. If the user is assigned this task, (s)he can view or change the elevator’s real time clock. To access the Real Time Clock window, click on the <strong>Controller</strong> menu, then select <strong>Real Time Clock.</strong></td>
</tr>
<tr>
<td><strong>Real Time Clock (view)</strong></td>
<td>Allows the user to view the Real Time Clock window. This window allows the user access to the elevator’s real time clock. If the user is assigned this task, (s)he can view the elevator’s real time clock, but may not change it. To access the Real Time Clock window, click on the <strong>Controller</strong> menu, then select <strong>Real Time Clock.</strong></td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Register Car Calls</td>
<td>Allows the user to register car calls from the Hoistway Display window. This task is only valid if the user has been assigned the <strong>Hoistway Display</strong> task.</td>
</tr>
<tr>
<td>Register Hall Calls</td>
<td>Allows the user to register hall calls from the Hoistway Display window. This task is only valid if the user has been assigned the <strong>Hoistway Display</strong> task.</td>
</tr>
<tr>
<td>Report Preferences (modify)</td>
<td>Allows the user to modify the Report Preferences window. This window contains all the settings that control storing and printing of the reports. If the user is assigned this task, (s)he can view or change the report preferences. To access the Report Preferences window, click on the <strong>File</strong> menu, select <strong>Preferences</strong>, then select <strong>Report Preferences</strong>.</td>
</tr>
<tr>
<td>Report Preferences (view)</td>
<td>Allows the user to view the Report Preferences window. This window contains all the settings that control the storing and printing of reports. If the user is assigned this task, (s)he can view the report preferences, but may not change them. To access the Report Preferences window, click on the <strong>File</strong> menu, select <strong>Preferences</strong>, then select <strong>Report Preferences</strong>.</td>
</tr>
<tr>
<td>Security Call Lockout</td>
<td>Allows the user to run the Security Call Lockout program which modifies the elevator security configuration. To run the Security Call Lockout program, click on the <strong>Options</strong> menu then select <strong>Security Call Lockout</strong>.</td>
</tr>
<tr>
<td>Traffic Analysis Report</td>
<td>Allows the user to view the Traffic Analysis report. To view the Traffic Analysis report, click on the <strong>Reports</strong> menu, select <strong>Hall Calls</strong>, then select <strong>Traffic Analysis</strong>.</td>
</tr>
<tr>
<td>System Performance</td>
<td>Allows the user to view the System Performance report. To view the System Performance report, click on the <strong>Reports</strong> menu, select <strong>Standard Reports</strong>, then select <strong>System Performance</strong>.</td>
</tr>
<tr>
<td>Update Reports</td>
<td>Allows the user to manually update the reports from the elevator system. To manually update the elevator’s reports, click on the <strong>Options</strong> menu then select <strong>Update Reports</strong>.</td>
</tr>
</tbody>
</table>
## Appendix C
Pager Events List

<table>
<thead>
<tr>
<th>Event ID</th>
<th>Event Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Fire Service Main</td>
</tr>
<tr>
<td>2</td>
<td>Fire Service Alternate</td>
</tr>
<tr>
<td>3</td>
<td>Bus Fuse Blown (2F)</td>
</tr>
<tr>
<td>4</td>
<td>Emergency Power</td>
</tr>
<tr>
<td>5</td>
<td>Bus Fuse Blown (2H)</td>
</tr>
<tr>
<td>6</td>
<td>Security</td>
</tr>
<tr>
<td>7</td>
<td>Balanced Mode</td>
</tr>
<tr>
<td>8</td>
<td>Lobby Up Peak Mode</td>
</tr>
<tr>
<td>9</td>
<td>Demand Up Peak Mode</td>
</tr>
<tr>
<td>10</td>
<td>Demand Down Peak Mode</td>
</tr>
<tr>
<td>14</td>
<td>Dispatch Failure</td>
</tr>
<tr>
<td>15</td>
<td>Long Hall Call Registration</td>
</tr>
<tr>
<td>30</td>
<td>Fire Service Phase 2</td>
</tr>
<tr>
<td>31</td>
<td>Inspection</td>
</tr>
<tr>
<td>32</td>
<td>Independent Service</td>
</tr>
<tr>
<td>33</td>
<td>Hospital Service</td>
</tr>
<tr>
<td>34</td>
<td>Earthquake</td>
</tr>
<tr>
<td>37</td>
<td>Inconspicuous Riser</td>
</tr>
<tr>
<td>38</td>
<td>Safety String Open</td>
</tr>
<tr>
<td>39</td>
<td>In-Car Stop Switch</td>
</tr>
<tr>
<td>40</td>
<td>Top Floor Demand</td>
</tr>
<tr>
<td>41</td>
<td>Bottom Floor Demand</td>
</tr>
<tr>
<td>42</td>
<td>Time Out of Service</td>
</tr>
<tr>
<td>43</td>
<td>Motor Limit Timer</td>
</tr>
<tr>
<td>Event ID</td>
<td>Event Name</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------</td>
</tr>
<tr>
<td>44</td>
<td>Valve Limit Timer</td>
</tr>
<tr>
<td>45</td>
<td>Communication Loss</td>
</tr>
<tr>
<td>46</td>
<td>Door Close Protection</td>
</tr>
<tr>
<td>48</td>
<td>Bus Fuse Blown (2)</td>
</tr>
<tr>
<td>49</td>
<td>Both USD and DSD are Open</td>
</tr>
<tr>
<td>50</td>
<td>DOL Open and DLK Active</td>
</tr>
<tr>
<td>51</td>
<td>Door Zone - Stepping Fault</td>
</tr>
<tr>
<td>52</td>
<td>Excessive Communication Error</td>
</tr>
<tr>
<td>53</td>
<td>Roll Back</td>
</tr>
<tr>
<td>54</td>
<td>Car Not Responding w/ DLK</td>
</tr>
<tr>
<td>55</td>
<td>Car Not Responding w/o DLK</td>
</tr>
<tr>
<td>56</td>
<td>Lost DLK During Run</td>
</tr>
<tr>
<td>57</td>
<td>Photo Eye Failure</td>
</tr>
<tr>
<td>58</td>
<td>CSA Redundancy LSR</td>
</tr>
<tr>
<td>59</td>
<td>CSA Redundancy CNP</td>
</tr>
<tr>
<td>60</td>
<td>CSA Redundancy UDF</td>
</tr>
<tr>
<td>61</td>
<td>CSA Redundancy GS Fail</td>
</tr>
<tr>
<td>62</td>
<td>CSA Redundancy DLS Fail</td>
</tr>
<tr>
<td>63</td>
<td>CSA Redundancy DOL Fail</td>
</tr>
<tr>
<td>64</td>
<td>CSA Redundancy LEV FLT</td>
</tr>
<tr>
<td>65</td>
<td>Governor Switch Open</td>
</tr>
<tr>
<td>66</td>
<td>Hoistway Safety Device Open</td>
</tr>
<tr>
<td>67</td>
<td>Car Safety Device Open</td>
</tr>
<tr>
<td>68</td>
<td>Safety Relay Circuit Open</td>
</tr>
<tr>
<td>69</td>
<td>Alarm - No Car Movement</td>
</tr>
<tr>
<td>70</td>
<td>Alarm - No Door Zone</td>
</tr>
<tr>
<td>71</td>
<td>LSA Movement Failure</td>
</tr>
<tr>
<td>Event ID</td>
<td>Event Name</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>72</td>
<td>Re-Leveling</td>
</tr>
<tr>
<td>73</td>
<td>Speed Out of Limits</td>
</tr>
<tr>
<td>74</td>
<td>Overtravel</td>
</tr>
<tr>
<td>75</td>
<td>Safety Edge Failure</td>
</tr>
<tr>
<td>76</td>
<td>Retiring Cam Failure</td>
</tr>
<tr>
<td>77</td>
<td>Timed Photoeye Failure</td>
</tr>
<tr>
<td>78</td>
<td>Photoeye Failure (Rear)</td>
</tr>
<tr>
<td>79</td>
<td>Drive Fault Detected</td>
</tr>
<tr>
<td>80</td>
<td>S25 Unit Over Temperature</td>
</tr>
<tr>
<td>81</td>
<td>Motor Limit Timer (LI)</td>
</tr>
<tr>
<td>82</td>
<td>Motor Limit Timer (INT)</td>
</tr>
<tr>
<td>83</td>
<td>Motor Limit Timer (LI &amp; INT)</td>
</tr>
<tr>
<td>84</td>
<td>Drive Motor Limit Timer</td>
</tr>
<tr>
<td>85</td>
<td>MP Power Up / Reset</td>
</tr>
<tr>
<td>86</td>
<td>CGP Power Down</td>
</tr>
<tr>
<td>87</td>
<td>CGP Power Up / Reset</td>
</tr>
<tr>
<td>88</td>
<td>Gate Switch Relay Redundancy Failure</td>
</tr>
<tr>
<td>89</td>
<td>Door Lock Relay Redundancy Failure</td>
</tr>
<tr>
<td>90</td>
<td>Inspection/Leveling Over speed Failure</td>
</tr>
<tr>
<td>91</td>
<td>Hatch Door Interlock Fail</td>
</tr>
<tr>
<td>92</td>
<td>Stopped Out of Door Zone</td>
</tr>
<tr>
<td>93</td>
<td>Hall Call Common Fuse Fail</td>
</tr>
<tr>
<td>94</td>
<td>Lobby Hall Call Fuse Fail</td>
</tr>
<tr>
<td>95</td>
<td>Hall Call Light Fuse Fail</td>
</tr>
<tr>
<td>96</td>
<td>Car Call Common Fuse Fail</td>
</tr>
<tr>
<td>97</td>
<td>Car Call Light Fuse Fail</td>
</tr>
<tr>
<td>98</td>
<td>Door Motor Overload Fail</td>
</tr>
<tr>
<td>Event ID</td>
<td>Event Name</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>99</td>
<td>Normal Mode</td>
</tr>
<tr>
<td>100</td>
<td>Top Final Limit Sw. Open</td>
</tr>
<tr>
<td>101</td>
<td>Emer. Terminal Sw. Failure</td>
</tr>
<tr>
<td>102</td>
<td>Up Fast Valve Fault</td>
</tr>
<tr>
<td>103</td>
<td>Down Fast Valve Fault</td>
</tr>
<tr>
<td>104</td>
<td>Run Pump Motor Fault</td>
</tr>
<tr>
<td>105</td>
<td>Starter #1 Fault</td>
</tr>
<tr>
<td>106</td>
<td>Starter #2 Fault</td>
</tr>
<tr>
<td>107</td>
<td>Starter #3 Fault</td>
</tr>
<tr>
<td>108</td>
<td>Up Slow Valve Fault</td>
</tr>
<tr>
<td>109</td>
<td>Down Slow Valve Fault</td>
</tr>
<tr>
<td>110</td>
<td>ROFRT Redundancy Fault</td>
</tr>
<tr>
<td>111</td>
<td>RSTOP Redundancy Fault</td>
</tr>
<tr>
<td>112</td>
<td>RPT Redundancy Fault</td>
</tr>
<tr>
<td>113</td>
<td>SAFC Redundancy Fault</td>
</tr>
<tr>
<td>114</td>
<td>SAFH Redundancy Fault</td>
</tr>
<tr>
<td>115</td>
<td>GOV Redundancy Fault</td>
</tr>
<tr>
<td>116</td>
<td>SAF Redundancy Fault</td>
</tr>
<tr>
<td>117</td>
<td>RSAFR Redundancy Fault</td>
</tr>
<tr>
<td>118</td>
<td>RESBYP Redundancy Fault</td>
</tr>
<tr>
<td>119</td>
<td>PLD Fault</td>
</tr>
<tr>
<td>120</td>
<td>2BI Redundancy Fault</td>
</tr>
<tr>
<td>121</td>
<td>REI Redundancy Fault</td>
</tr>
<tr>
<td>122</td>
<td>Red. Emergency Brake Fault</td>
</tr>
<tr>
<td>123</td>
<td>EBR Button Fault</td>
</tr>
<tr>
<td>124</td>
<td>RBK Redundancy Fault</td>
</tr>
<tr>
<td>125</td>
<td>RMR Redundancy Fault</td>
</tr>
<tr>
<td>Event ID</td>
<td>Event Name</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>126</td>
<td>Inspection Input Fault</td>
</tr>
<tr>
<td>127</td>
<td>Hoistway Access Input Flt.</td>
</tr>
<tr>
<td>128</td>
<td>INUP Redundancy Fault</td>
</tr>
<tr>
<td>129</td>
<td>INDN Redundancy Fault</td>
</tr>
<tr>
<td>130</td>
<td>Front Door Input Fault</td>
</tr>
<tr>
<td>131</td>
<td>DLK Redundancy Fault</td>
</tr>
<tr>
<td>132</td>
<td>RCHDT Redundancy Fault</td>
</tr>
<tr>
<td>133</td>
<td>Door Zone Input Fault</td>
</tr>
<tr>
<td>134</td>
<td>RLULD Redundancy Fault</td>
</tr>
<tr>
<td>135</td>
<td>Red. Inspection Input Flt.</td>
</tr>
<tr>
<td>136</td>
<td>Red. Access Input Fault</td>
</tr>
<tr>
<td>137</td>
<td>Overspeed Fault</td>
</tr>
<tr>
<td>138</td>
<td>Direction Input Fault</td>
</tr>
<tr>
<td>139</td>
<td>RH Redundancy Fault</td>
</tr>
<tr>
<td>140</td>
<td>TEST Redundancy Fault</td>
</tr>
<tr>
<td>141</td>
<td>ESBYP Redundancy Fault</td>
</tr>
<tr>
<td>142</td>
<td>MPSAF Redundancy Fault</td>
</tr>
<tr>
<td>143</td>
<td>MGR Redundancy Fault</td>
</tr>
<tr>
<td>144</td>
<td>REL Redundancy Fault</td>
</tr>
<tr>
<td>145</td>
<td>CTOS Redundancy Fault</td>
</tr>
<tr>
<td>146</td>
<td>CTDIF Redundancy Fault</td>
</tr>
<tr>
<td>147</td>
<td>H Redundancy Fault</td>
</tr>
<tr>
<td>148</td>
<td>Rear Door Input Fault</td>
</tr>
<tr>
<td>149</td>
<td>End of Run Cycle Test Flt.</td>
</tr>
<tr>
<td>150</td>
<td>Hoistway Sfty Device Open</td>
</tr>
<tr>
<td>151</td>
<td>DP Differential Fault</td>
</tr>
<tr>
<td>152</td>
<td>PFLT Fault</td>
</tr>
<tr>
<td>Event ID</td>
<td>Event Name</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>153</td>
<td>Drive Failed to Respond</td>
</tr>
<tr>
<td>154</td>
<td>Stop Sw/ Safety Relay Ckt</td>
</tr>
<tr>
<td>155</td>
<td>Final limit Sw. Open</td>
</tr>
<tr>
<td>156</td>
<td>Buffer switch open</td>
</tr>
<tr>
<td>157</td>
<td>Motor Overload Failure</td>
</tr>
<tr>
<td>158</td>
<td>Red. DLK String Failure</td>
</tr>
<tr>
<td>159</td>
<td>Red. DN Normal Limit</td>
</tr>
<tr>
<td>160</td>
<td>Red. UP Normal Limit</td>
</tr>
<tr>
<td>161</td>
<td>Red. DN Slowdown Limit #2</td>
</tr>
<tr>
<td>162</td>
<td>Red. UP Slowdown Limit #2</td>
</tr>
<tr>
<td>163</td>
<td>Red. DN Slowdown</td>
</tr>
<tr>
<td>164</td>
<td>Red. UP Slowdown Limit</td>
</tr>
<tr>
<td>165</td>
<td>Red. Gate Switch Failure</td>
</tr>
<tr>
<td>166</td>
<td>Red. DLS Relay Failure</td>
</tr>
<tr>
<td>167</td>
<td>NYCHA-Red. Final Limit Switch Relay Failure</td>
</tr>
<tr>
<td>168</td>
<td>NYCHA-Red. Hall Safety Circuit Relay Failure</td>
</tr>
<tr>
<td>169</td>
<td>NYCHA-Red. Car Safety Circuit Relay Failure</td>
</tr>
<tr>
<td>170</td>
<td>NYCHA-Final Limit Switch Open</td>
</tr>
<tr>
<td>171</td>
<td>NYCHA-Governor Switch Open</td>
</tr>
<tr>
<td>172</td>
<td>NYCHA-Buffer Switch Open</td>
</tr>
<tr>
<td>173</td>
<td>NYCHA-Comp. Sheave Open</td>
</tr>
<tr>
<td>174</td>
<td>NYCHA-Pit Stop Switch Open</td>
</tr>
<tr>
<td>175</td>
<td>NYCHA-Top &amp; Side Emerg. Exit Switch Open</td>
</tr>
<tr>
<td>176</td>
<td>NYCHA-Safety Clamp Switch Open</td>
</tr>
<tr>
<td>177</td>
<td>NYCHA-Car Top Stop Switch Open</td>
</tr>
<tr>
<td>178</td>
<td>NYCHA-Motor Overload Failure</td>
</tr>
<tr>
<td>179</td>
<td>NYCHA-Safety String Open</td>
</tr>
<tr>
<td>Event ID</td>
<td>Event Name</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>180</td>
<td>NYCHA-Red. Error For RGS Fault</td>
</tr>
<tr>
<td>181</td>
<td>NYCHA-Red. Door Lock String Failure</td>
</tr>
<tr>
<td>182</td>
<td>NYCHA-Red. Down Normal Limit Failure</td>
</tr>
<tr>
<td>183</td>
<td>NYCHA-Red. Up Normal Limit Failure</td>
</tr>
<tr>
<td>184</td>
<td>NYCHA-Down Normal Limit Failure</td>
</tr>
<tr>
<td>185</td>
<td>NYCHA-Up Normal Limit Failure</td>
</tr>
<tr>
<td>186</td>
<td>NYCHA-Red. Down Slowdown Limit #2 Failure</td>
</tr>
<tr>
<td>187</td>
<td>NYCHA-Red. Up Slowdown Limit #2 Failure</td>
</tr>
<tr>
<td>188</td>
<td>NYCHA-Down Slowdown Limit Failure</td>
</tr>
<tr>
<td>189</td>
<td>NYCHA-Red. Down Slowdown Limit Failure</td>
</tr>
<tr>
<td>190</td>
<td>NYCHA-Up Slowdown Limit Failure</td>
</tr>
<tr>
<td>191</td>
<td>NYCHA-Red. Up Slowdown Limit Failure</td>
</tr>
<tr>
<td>192</td>
<td>NYCHA-DLS Relay Failure</td>
</tr>
<tr>
<td>193</td>
<td>NYCHA-Gate Switch Failure</td>
</tr>
<tr>
<td>194</td>
<td>NYCHA-Door Motor Overload Failure</td>
</tr>
<tr>
<td>195</td>
<td>NYCHA-In Car Stop Switch Open</td>
</tr>
</tbody>
</table>
Appendix D
Running CMS in Windows® XP

Introduction

Windows® XP is the fastest Windows ever. Windows XP Professional includes networking and other features that make it ideal for business and advanced home computing. Windows XP uses processor time to handle system performance according to default settings, which can be adjusted for your computing needs. Also, settings that govern visual effects enhance the appearance of the Windows XP interface, but can slow down performance. You can fine-tune settings in Windows XP Professional to improve performance as well as change the view of how things display on your screen.

Menu Displays

Windows XP has a total new look and feel to it. One of the most noticeable are the menus and icons. The way you see the menus and icons on your screen can be changed. An example of two of the types of viewing options you have are the Classic and Windows XP.

Classic Start Menu button -

Windows XP Start Menu Button -
If you are more used to the classic look this is how you change the way Windows XP menus look.

1. Right click the desktop (Windows background screen).
2. Click **Properties**.
3. Change the **Theme** to Classic Windows.
4. Click **OK**.

You can use this tip to speed up the way menus display in Windows XP.

1. Click **Start**.
2. Click **Control Panel**.
3. Click **Performance and Maintenance**.
4. Click **System**.
5. Click the **Advanced** tab.

6. Under Performance, click **Settings**.

7. On the **Visual Effects** tab of the Performance Options window, click **Fade or slide menus into view** to remove the check.

8. Click **OK**.

Now when you bring up a collapsed menu, it will expand without delay.

---

**Improving Performance**

You may notice slight delays when running CMS software under Windows XP. This is due to some default performance settings. While these settings will not effect the software, they may cause some frustration. You can change the way Windows XP reacts to menu selections and program displays appearing on the screen by optimizing the performance settings. To run Windows XP in optimal mode, make the following changes.

1. Click **Start** or [Start](#)

2. Click **Control Panel**.
3. Click **System**.

4. In the System Properties window, click the **Advanced** tab.

5. In the Performance box, click **Settings**.

7. Click the Advanced tab.

8. On the Advanced tab, click the two radio buttons labeled Programs.

9. Then click OK.
Index

Account Settings, 1-42
   Select User, 1-46
   Add User, 1-46
   Modify User, 1-46

Add System, 2-1
   Modem Connection, 2-2
   Ethernet Connection, 2-2
   Address, 2-3
   Contact, 2-3
   Mechanic, 2-4
   Elevator Company, 2-5
   Listing, 2-7

Auto Hoistway Display Setup, 1-41

Basic Concepts, 1-14
   About Windows, 1-14
   Navigating the Menu, 1-15
   About Environment, 1-17

Car Call Log, 4-27
   Date and Time, 4-28
   Select, 4-29
   Preferences, 4-30
   Cars In Service, 4-31
   Summary, 4-31
   Sample Analysis, 4-32

Car Flags, 3-46

Car Status, 3-47

Car Status Messages, Appendix-1

Car to Lobby, 3-33

Cars In Service, 4-2

Close System, 2-11

CMS Installation, 1-10

Common Report Windows, 4-2
   Cars In Service, 4-2
   Graph Type, 4-3
   Search, 4-3
   Sort, 4-4

Connecting to a Job, 3-1

Controller Configuration, 3-10
   Labels, 3-11
   Stops/Openings, 3-12
   Options, 3-13
   COM Ports, 3-14

Controller CMS Parameters, 3-6
   Without CGP Processor, 3-8

Create Maintenance Log, 3-51

Disconnecting from a Job, 3-3

Dispatcher, 3-15
   System Parameters, 3-16
   Dispatching Configuration, 3-18
   Timer Table, 3-20
   Lobby Up Peak, 3-22
   Variables for Lobby Up Peak, 3-24
   Car Operating Parameters, 3-25

Emergency Transmission Errors Report, 4-10
   Date and Time, 4-12
   Select, 4-12
   Preferences, 4-13
   Cars In Service, 4-14
   Summary, 4-14
   Search, 4-14
   Sample Analysis, 4-14

Emergency Report, 4-5
   Date and Time, 4-6
   Select, 4-7
   Preferences, 4-8
   Summary, 4-9
   Cars In Service, 4-10
   Sample Analysis, 4-10

Event Calendar, 4-40
   Date and Time, 4-41
   Select, 4-42
   Preferences, 4-43
   Cars In Service, 4-44
   Summary, 4-44
   Search, 4-44
   Sample Analysis, 4-45

Exit, 1-19

Graph Type, 4-3
Group Status, 3-49

Hall Call Analysis, 4-15
  Date, 4-16
  Preferences, 4-17
  Cars In Service, 4-17
  Sample Analysis, 4-17

Hall Call Distribution, 4-37
  Date and Time, 4-38
  Preferences, 4-39
  Cars In Service, 4-39
  Sample Analysis, 4-39

Hall Call Log, 4-18
  Date and Time, 4-19
  Select, 4-20
  Preferences, 4-21
  Cars In Service, 4-22
  Summary, 4-22
  Sample Analysis, 4-23

Hoistway Display, 3-43

Independent Service, 3-30

Installing CMS for Windows, 1-4
  System Requirements, 1-4
  PC Installation, 1-5
  CMS Installation, 1-10
  Multi-user Setup, 1-11
  Starting CMS for the First Time, 1-11

Keyboard Control for Elevators, 3-27
  Independent Service, 3-30
  Car to Lobby, 3-33
  Out of Service, 3-36
  Swing Operation, 3-39

Line Driver, 1-5

Login, 1-19

Logout, 1-19

Maintenance Mechanics, 1-37
  Add Maintenance Mechanic, 1-38
  Edit Maintenance Mechanic, 1-39

Maintenance Timer, 1-46

Maintenance Log, 4-45

Median Wait Time, 4-22

Minimum Wait Time, 4-22

Modem
  Installation, 1-5, 1-8
  Parameters, 3-9

Modify System, 2-9
  Edit, 2-9
  Add, 2-10
  Delete, 2-10
  View, 2-11

Multi-user Setup, 1-11

Open System, 2-7

Options, 3-50
  Update Reports, 3-50
  Auto-Update, 3-50
  Create Maintenance Log, 3-51
  Security Interface Software, 3-52

Out of Service, 3-36

Pager Setup, 1-29
  Add Pager, 1-31
  Pager Jobs, 1-33
  Pager Schedule, 1-34
  Add a Pager Schedule, 1-35
  Edit Pager, 1-36

Pager Events List, Appendix-15

PC Installation, 1-5

Performance (system), 4-33

Preferences, 1-20
  Show/Hide Date and Time, 1-20
  Report Preferences, 1-21

Programmable Events, 3-41

Real Time Clock, 3-4

Search, 4-3

Security Interface Software, 3-52

Setup, 1-22
  Auto-Update Setup, 1-22
  Emergency Report Setup, 1-24
  COM Port Setup, 1-27
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort</td>
<td>4-4</td>
</tr>
<tr>
<td>Starting CMS for the First Time</td>
<td>1-11</td>
</tr>
<tr>
<td>Swing Operation</td>
<td>3-39</td>
</tr>
<tr>
<td>System Performance</td>
<td>4-33</td>
</tr>
<tr>
<td>Date</td>
<td>4-34</td>
</tr>
<tr>
<td>Preferences</td>
<td>4-35</td>
</tr>
<tr>
<td>Summary</td>
<td>4-36</td>
</tr>
<tr>
<td>Sample Analysis</td>
<td>4-36</td>
</tr>
<tr>
<td>Technical Support</td>
<td>1-17</td>
</tr>
<tr>
<td>About CMS</td>
<td>1-18</td>
</tr>
<tr>
<td>Terminal Server</td>
<td>1-5</td>
</tr>
<tr>
<td>Total Number of Calls</td>
<td>4-22</td>
</tr>
<tr>
<td>Traffic Analysis</td>
<td>4-24</td>
</tr>
<tr>
<td>User (select)</td>
<td>1-46</td>
</tr>
<tr>
<td>User Tasks (Privileges)</td>
<td>Appendix-6</td>
</tr>
<tr>
<td>Welcome</td>
<td>1-2</td>
</tr>
<tr>
<td>Windows XP, running CMS in</td>
<td>Appendix-22</td>
</tr>
</tbody>
</table>